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GENERAL INFORMATION

SECTION 1 GENERAL INFORMATION

1.1 SCOPE OF MANUAL

This addendum updates the following LTR®
9800-series service manual with the additional infor-
mation needed to service 9800-series SMARTNET ™/
SmartZone® transceivers.

98xx Series UHF/800/900 M Hz Service Manual,
Part No. 001-9800-001

1.2 DIFFERENCES BETWEEN LTR AND
SMARTNET/SMARTZONE VERSIONS

1.2.1 HARDWARE DIFFERENCES

The 98xx SMARTNET/SmartZone transceivers
use the same basic PC boards and mechanical package
used for high tier LTR models. The only change is the
addition of a DSP board that mounts on top of the
current audio/logic board. This DSP board provides
the SMARTNET/SmartZone control and signal
processing functions.

Therefore, use the service manual listed above to
service al boards except the DSP board. Service and
interfacing information for that board islocated in
Section 5 of this addendum.

1.2.2 SOFTWARE DIFFERENCES

The audio/logic and DSP board operating soft-
ware (firmware) is unique to this transceiver. In addi-
tion, the programming and tuning software is also
different. Therefore, new Operation, Programming,
and Alignment sections are included in this manual.

The programming and tuning programs are now
Windows® based. Therefore, Windows 95, 98, or NT
4 or later isrequired to run these programs. The
programming software is called PCTrunk™, and the
alignment software is called PCTune™ . Refer to
Sections 1.5.5 and 1.5.6 for more information on
programming and alignment.

1.3 TRANSCEIVER IDENTIFICATION
The transceiver identification (serial) number is

printed on alabel that is attached to the chassis. The
information contained in this number is as follows.

1-1

Model Revision Manufacture Warranty
From PN. Letter Date  Plant Number
| | | | |
98xx A A 02 0 A 12345

L A = Waseca
Type
A = SMARTNET/ Last Digit of Year
SmartZone
—— Week No. of Year

1.4 PART NUMBER BREAKDOWN

The following is a breakdown of the part number
used to identify this transceiver.

Band
1=VHF*
4=UHF
8 = 800 MHz
9 = 900 MHz

Type

1=_Low tier, dua BW
2 = Mid tier, dual BW*
3 = Hightier, dual BW
4=Low tier, 125kHz
5=Midtier, 12.5 kHz*
6 = High tier, 12.5 kHz
8 = High tier rem, dual BW
0 = Hightier rem, 12.5 kHz

Signaling
2=LTR
3=SMARTNET
4 = Multi-Net
5 = SmartZone

242 - 98X X -XXXX

Options[1

B/N = Comp/Data
C/O = Compander
D/P = Data Cable
E/Q = Enc/Comp
F/T = Enc/Comp/Dat
G/U = Comp/Acsry
H/V =Horn/Acsry
I/W = Enc/Comp/

Acsry Cable

[1] N-W models are
LTR-Net upgradable

Config.
1= _Low Pwr std*
2 =Mid Pwr std
3 = High Pwr std
| 6=Low Pwr std*
7=M.P.no acc
8=H.P. noacc

6 = LTR-Net
8=DaalTR

9 = Data Multi-Net
0 = Conv only*

NOTES

1. * These configurations are currently not available.
2. Mid power = 25W UHF, 15W 800/900 MHz;
High power = 40W UHF, 30W 800/900 MHz

FI’@ Range
0 = Full band (800/
900 MH2)
3= 430-470 MHz
5= 470-512 MHz

Revised January 2001
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1.5 MISCELLANEOUS
1.5.1 ACCESSORIES

Table 1-1isapartial listing of accessoriesthat are
available for 9800-series transceivers. Refer to this
table in the service manual for other accessories that
are available.

Table 1-1 98xx Accessories

Accessory Part No.

Optional SMARTNET/SmartZone key cap|587-9840-105
kit (see Section 1.5.2)

Programming Accessories

Remote Programming Interface (RPI) |023-9800-000
Cable, RPI to transceiver 597-2002-200
Cable, RPI to computer, 6 ft. 597-5900-002

(DBYF to DBOM)

PCTrunk personality programming
software, Win 95/NT, CD-ROM
PCTune alignment software (see Section | Contact Cust.

1.5.6) Service

023-9998-453

1.5.2 KEY CAP KITS

Key Cap Kit, Part No. 587-9840-003, is included
with each transceiver. Thiskit includes the five key
caps listed below.

EMER F1 F2 F3 SCAN

Optional Key Cap Kit, Part No. 587-9840-105, is
also available. This kit includes the key caps shown
below.

F1 F2 F3 F4 SCAN
BKLHT MSG HORN C/S DISP
PRIED SELSQ MON TGSEL PHONE
RESP  NUIS STATUS TXPWR (Blank)
ALERT EMER RWS TONES (Blank)

To remove akey cap, insert atool with asharp tip
in the dot on the bottom of the cap and carefully pry
against the front panel to release the cap.

Revised January 2001
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1.5.3 SYSTEMS, CHANNELS, AND ZONES

A zone and channel are selected to place and
receive calls. The following describes the relationship
between systems, channels, and zones.

Systems

A system as used with this transceiver is a collec-
tion of channels (talk groups) belonging to the same
repeater site. A system defines all the parameters and
protocol definitions required to accessasite. Up to
1 conventional system and 15 SmartNet/SmartZone
systems can be programmed (16 total). Systems are
used for programming purposes only and are not
selectable by the user.

Channels

A channel selects aradio channel or talk group in
asystem asfollows:

Conventional Mode - A channel selects a specific
radio channel, Call Guard (CTCSS/DCS) squelch
coding, and other parameters unique to that channel.

SmartNet/SmartZone Mode - A channel selectsa
specific talk group, announcement group, emergency
group, and other parameters unique to that channel.

As previously described, amaximum of up to 256
channels can be programmed with the preceding
modes. The conventional system can be programmed
with up to 256 channels, and each SmartNet/Smart-
Zone system can be programmed with up to 256 talk
groups (channels).

Thereforeit istheoretically possible to program
any combination of these systems that produces up to
256 total channels. However, the maximum number
may be limited by the available memory. For example,
since more memory is required to program a SmartNet
system than a conventional system, the total number of
channels decreases as the number of SmartNet systems
increases. The programming software displays a bar
graph which shows the amount of available memory
space that is used by the current data. Refer to Section
3.1.10 for more information.
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Zones

A zoneisacollection of up to 16 channels of any
type (conventional or SmartNet/SmartZone). For
example, a zone could include 12 conventional chan-
nels and 4 SmartNet channels. Zones are similar to
banks used in other EFJohnson transceivers. One use
of zones may be to program the channels used for
operation in a specific geographical area. Up to 16
zones can be programmed.

1.5.4 NPSPAC MODELS

All 800 MHz models meet the stricter specifica-
tions established by NPSPAC (National Public Safety
Panel Advisory Committee) for public safety frequen-
ciesfrom 821-824 and 866-869 MHz. Maximum devi-
ation on NPSPAC channelsis 4 kHz, and it is automat-
icaly changed to the level set for NPSPAC channels
when one of these channelsis selected.

1-3

1.5.5 PROGRAMMING

Thetransceiver is programmed using a PC-
compatible computer, the EFJohnson Remote
Programming Interface (RPI), and the PCTrunk™
programming software (see Table 1-1). Programming
is described in Section 3. The operating software
(firmware) is Flash upgradableif required. Keypad
programming is not available with this transceiver.

1.5.6 TRANSCEIVER ALIGNMENT

Transceiver alignment is performed using the
same computer and RPI used to perform program-
ming (see preceding section) and special PCTune™
software. Only three adjustments are made manually
and the rest are made electronically using the PCTune
software. Therefore, if the manual adjustments do not
reguire readjustment, the transceiver can be tuned
without removing the top cover to accessinterna
adjustments. Refer to Section 4 for more information.

Revised January 2001
Part No. 001-9800-501
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SECTION 2 OPERATION

Option Switches

Speaker

Microphone  On-Off/Volume Select Switch
Jack (Press/Rotate) (Press/Rotate)

Figure 2-1 Front Panel Controls And Indicators

2.1 FEATURES
2.1.1 GENERAL FEATURES

Up to 16 zones with home zone select

Up to 16 channels per zone (256 channels total)
Standard and radio-wide scan

Five programmabl e option switches

Time-out timer

16-character LCD a phanumeric display with

8 status annunciators

2.1.2 CONVENTIONAL FEATURES

Up to 256 channels programmable

Scanning with three user programmabl e scan lists
Priority channel sampling when scanning

Busy channel lockout (transmit disable on busy)
Monitor mode

Call Guard® (CTCSS/DCS) or carrier squelch
control

Penalty and conversation timers

Repeater talk-around

DTMF/ANI signaling

User selectable high and low power output

2.1.3 SMARTNET " Il FEATURES

¢ Up to 256 talk groups programmable

Group, Enhanced Private Conversation™, Private
Conversation |1, and telephone Calls

Call Alert™ (paging)

Emergency alarms and calls

Messaging

Priority monitor scanning with user programmable
scan lists

Failsoft operation

® Dynamic regrouping

2.1.4 SMARTZONE® FEATURES

Site trunking
Site search
Site lock/unlock

2.2 CONTROLS AND DISPLAY

On-Off Volume - Pressing this knob turns power on
and off, and rotating it sets the speaker volume (see
Section 2.3.2).

Revised January 2001
2-1 Part No. 001-9800-501
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Select Switch - Rotating this switch increases or
decreases the selected channel. It is aso used for other
functions such as selecting the zone and scrolling
through lists. See Section 2.3.5 for more information.

Option Switches- Thefivefront panel option switches
can be programmed for various functions. Refer to
Section 2.3.4 for more information.

Transmit/Busy Indicator - Indicates the following
conditions:
Red - Transmitter is keyed
Green - The currently selected receive channel may
be busy because acarrier (signal) is being
detected (see Section 2.4.3).

Microphone Jack - Connection point for the
microphone.

Microphone Push-To-Talk (PTT) Switch - Push-
button on the microphone which is pressed to key the
transmitter.

Speaker - Theinternal speaker islocated behind the
grille. An optional speaker can be connected to the
external speaker jack located on the back. See* Speaker
Jack” description in next section for more information.

Power
Jack

L

Antenna
Jack

Ext. Speaker
Jack

2.2.1 REAR PANEL JACKS AND CONNECTORS

AntennaJack - Miniature UHF jack for connecting the
50-ohm antenna.

Power Jack - Connection point for the power cable
which attachesto the vehicle battery. A nominal 12-volt
DC, negative ground power sourceis required.

Speaker Jack - Connection point for an optional
external 4.7-ohm, 5-watt speaker. The internal speaker

Revised January 2001
Part No. 001-9800-501

2-2

is automatically disabled when a speaker is plugged
into this jack.

Accessory Cable (Not Shown) - This optional pigtail

cableinstallsin the speaker jack opening and is used
to connect the ignition sense input and other outputs.

2.2.2 DISPLAY DESCRIPTION

Std Scan In Scan
Enabled List

Keypad
Prg Mode

Radio- Priority
Wide Scan Channel
\

. J

/ \ \
Upper and Lower \ Talk-Around Private  Monitor
8-Character Displays\ Mode Call Mode

Telephone Call

Upper 8-Character Display - This alphanumeric
display indicates the channel alias or information
about the selected mode. With conventional operation,
it may also indicate the channel number or frequency
(see Section 2.4.2).

Lower 8-Character Display - This aphanumeric
display indicates additiona information pertaining to
the current mode when necessary.

S - Indicates that standard scanning is enabled (see
Section 2.3.11). Standard and radio wide scanning
cannot be enabled at the same time.

|___| - The box around the “ S’ indicates that the current
conventional or SMARTNET/SmartZone channel isin
the standard scan list (Section 2.3.11).

'." - With SMARTNET/SmartZone channels only,
Indicates that the telephone (interconnect) mode is
selected (Section 2.5.6).
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z - Indicates that radio-wide scan is enabled (see
section 2.3.11).

A - Indicates that repeater talk-around is enabled on
the selected conventional channel (see Section 2.4.9).

C - Indicates that a SMARTNET/SmartZone private
call isoccurring (Sections 2.5.4 and 2.5.5).

‘ - Indicates that the conventional monitor mode is
enabled (Section 2.4.4).

P - Indicatesthat the sal ected conventional channel is
apriority channel (Section 2.4.12).

2.3 GENERAL OPERATION
2.3.1 INTRODUCTION

This section (2.3) describes features available
with both conventional and SMARTNET/SmartZone
(trunked) operation. For information on features
unique to conventional channels, refer to Section 2.4,
and for information on features unique to
SMARTNET/SmartZone channels, refer to
Section 2.5.

2.3.2 TURNING POWER ON AND SETTING
VOLUME

Power is turned on and off by pressing the On-
Off/Volume switch on the front panel. When power is
initially turned on, an alert tone sounds and the radio
software version is momentarily displayed. The zone
dliasisthen displayed followed by the unit ID if a
SMARTNET/SmartZone channel is selected (see
Section 2.5.2). The selected channel is then indicated.
When power is turned off, the display may remain on
for afew seconds. It is recommended that power not
be turned back on again until the display is blank.

Thevolume level is adjusted by rotating the On-
Off/Volume switch. The relative volume level can be
determined by noting the position of the index on the
knob. You may aso be able to enable areference tone
for setting the volume as follows:

* |f key presstones are enabled (see Section 2.3.8), a
short tone sounds when front panel option keys are
pressed.

* |f aconventional channel is selected and the
Monitor option switch is programmed (see Section
2.4.4), pressing that switch unsquel ches/squel ches
the receiver and either voice or background noiseis
heard. If a SMARTNET/SmartZone channel is
selected, the receiver cannot be manually
unsquel ched.

2.3.3 BACKLIGHT

The backlight for the display and keypad can be
manually turned on and off if the Backlight option
switch is programmed. Pressing this switch cycles
between the Bright, Dim, and Off modes. If this switch
is not programmed, the backlight is fixed in one of
these modes.

2.3.4 OPTION SWITCHES

All five push-button switches on the front panel
are programmabl e for the functionsindicated in Table
2-1. If your radio is programmed with both conven-
tional and SMARTNET/SmartZone channels (see
Section 2.3.12), these option switches can be
programmed to control a different set of functions for
each channel type. For example, aswitch could select
the Monitor Mode when a conventional channel is
selected and Private Calls when a SMARTNET/Smart-
Zone channel is selected. If no option switch has been
programmed to control a particular function, that func-
tion may not be available or in afixed mode.

2.3.5 CHANNEL AND ZONE SELECTION
Channel Select

To change the selected channel, rotate the Select
switch. The selected channel alias (name) isindicated
on the top line of the display. With conventiona chan-
nels, the channel number or frequency may also be
displayed as described in Section 2.4.2.

Zone Sdlect

A zoneisagroup of up to any 16 conventional
and SMARTNET/SmartZone channels defined by
programming (see Section 1.5.3). Up to 16 zones can
be programmed for atotal of 16 x 16 or 256 channels.
One use of zones may be to select groups of channels
programmed for operation in different geographical
areas or radio systems. Zones are selected as follows:

Revised January 2001
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1. Pressthe Zoneoption switch and the alias (name) of
the current zone isindicated on the upper line of the

display.

2. Rotate the Select switch to display thedesired zone.
Then to select that zone and exit thismode, pressthe
Select switch or wait 4 seconds.

Table 2-1 Option Switch Functions

Function Conv. Srl\r::trt S;gr: See
[Sugg. Sw. Label] |Mode Model Mode Section

Backlight [BKLHT] X X X 233
Call Alert [ALERT] X X 257
Call Response [RESP] X X 254,255
Displayed Information | X 24.2
[DISP]
Emergency [EMER] X X 25.10
High/Low Power X 2.4.10
[TXPWR]
Home Zone X X X 2.36
Message [M SG] X X 258
Monitor [MON] X 24.4
Normal/Selective X 24.6
[SELSQ]
Phone [PHONE] X X 2.5.6
Priority Edit [PRIED] X 2412
Private Call X X |254,255
Radio Wide Scan X X X 2311
[RWS]
Repeater Talk-Around X 249
Scan [SCAN] X X X 2311
Scan Edit X X X 2411
Site Lock X 2514
Site Search X 2514
Status [STATUS] X X 259
Tones On-Off [TONES] X X X 2.3.8
Zone X X X 235

2.3.6 HOME ZONE

The radio can be programmed with a home zone.
Then when power isturned on, the radio can be
programmed so that either the home zone or last
selected zone is automatically selected.

If the Home Zone option switch is programmed,
it can be used to quickly select or change the home

Revised January 2001
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zone. To select the home zone, simply press this
switch. Then to change the home zone to the currently
selected zone, press and hold this switch until atone
sounds (approximately 1 second).

2.3.7 TIME-OUT TIMER

The time-out timer disables the transmitter if itis
keyed for longer than the programmed time. It can be
programmed on each channel for times from 15
seconds up to 3 minutes, 45 seconds or disabled (not
used). If the transmitter is keyed continuously for
longer than the programmed time, the transmitter is
disabled and an invalid condition tone sounds. Five
seconds before time-out occurs, an alert tone soundsto
indicate that time-out is approaching. The timer and
tone are reset by releasing the PTT switch.

One use of thisfeature is to prevent a channel
from being kept busy for an extended period by an
accidentally keyed transmitter. It can also prevent
possible transmitter damage caused by transmitting for
an excessively long period. Conventional channels can
also be programmed with the Penalty and Conversa-
tion timers that are described in Sections 2.4.7 and
2.4.8.

2.3.8 TONE ENABLE/DISABLE

The supervisory tones (see Section 2.6) can be
enabled and disabled by the Tones On-Off option
switch if it is programmed. When tones are enabled by
this switch, “TONE ON” is momentarily displayed on
the lower line and a tone sounds. Conversely, when
tones are disabled, “TONE OFF” is displayed and no
tone sounds. If the Tones On-Off option switch is not
programmed, tones are fixed in the on or off mode by
programming.

2.3.9 POWER TURN-OFF DELAY

Thetransceiver can be installed so that the
vehicle ignition switch as well as the front-panel
power switch controls transceiver power. Thisis done
by connecting the accessory ignition switch wireto a
power source switched by the ignition switch. Power
off delays of 0-254 minutes or Forever can then be
programmed. Thisdelay can be overridden at any time
by turning power off using the front-panel power
switch or turning the ignition switch back on.
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A turn-off delay allows the radio to remain active
for the programmed delay time after the ignition switch
isturned off. At the same time, advantages of ignition
switch control can be utilized such as preventing
battery discharge that may occur if the transceiver is
accidentally left on for an extended period.

2.3.10 TEMPERATURE AND VOLTAGE
MONITORING

Excessive Transceiver Temperature

If theinternal transceiver temperature becomes
excessive, atone sounds and “HOT” is displayed on
the bottom line. Transmit power is then automatically
cut back to approximately 1/3 of normal to limit heat
generation. When the temperature is not longer exces-
sive, power output automatically returnsto normal.
This condition may be caused by transmitting for
extended periods or operating in avery warm
environment.

If the temperature continues rising to the point
where serious transceiver damage could result, “TOO
HOT” isdisplayed, atone sounds, and the transmitter
isdisabled. The PTT switch must then be released and
the temperature drop to the excessive range or lower to
transmit again.

Low Voltage Conditions

If the voltage applied to the transceiver decreases
to the point where improper operation could result,
“LO VOLT” isdisplayed on the bottom line, atone
sounds, and the transmitter is disabled. This condition
isusually caused by a discharged vehicle battery. To
clear this condition, operate the vehicle to charge the
battery or transmit with the vehicle running.

2.3.11 SCANNING
Introduction

Scanning cyclesthrough alist of channels, called
a“scan list”, checking each for messages. When a
message is detected that your transceiver is
programmed to receive, scanning stops and the
message is received. Shortly after the messageis
complete, scanning resumes (unless it has been
disabled). If the microphone off-hook condition is

detected, the microphone must also be on-hook for
scanning to occur. An off-hook condition also disables
coded squelch as described in Section 2.4.3

There are two basic scan modes: Standard and
Radio Wide. The Standard mode is unique to the type
of channel selected (conventional or SMARTNET/
SmartZone), and the Radio Wide mode is the same
regardless of the channel type selected. Only one of
these scan modes can be enabled at atime. Therefore,
if standard scanning is enabled while radio wide scan-
ning is occurring, radio wide scanning is automatically
disabled and vice versa. More information on these
modes follows.

Standard Scanning

Standard scanning monitors only channels that
are the same type as that currently selected. There-
fore, if aconventional channel is selected, only
conventional channels are scanned, and if a
SMARTNET channel is selected, only SMARTNET
channels are scanned. Standard scanning is turned on
and off by the Scan option switch asfollows. If this
switch is not programmed, standard scanning is not
available.

* Toturn standard scanning on, press the Scan option
switch. Scanning is enabled when the“S” icon is
indicated in the upper left corner of the display and
SCAN x (conventional) or SCAN ON
(SMARTNET/SmartZone) is briefly displayed on
the lower line of the display. The “Xx” isthe number
of the conventional scanlist (1, 2, or 3) that is
selected. Refer to Section 2.4.11 for more
information.

* To turn scanning off, press the Scan option switch
again. The“S” icon isthen no longer indicated and
“SCAN OFF" is briefly displayed.

¢ |f the zone or channel is changed while scanning is
selected, scanning continues on the same or a
different scan list (see scan list information which
follows).

Radio Wide Scanning

Radio wide scanning monitors the channelsin the
preprogrammed radio wide scan list (seeinformation
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which follows). Thislist may contain up to 16 chan-
nels of any type (conventional or SMARTNET/Smart-
Zone) assigned to any zone. Radio wide scanning is
turned on and off by the Radio Wide Scan option
switch as follows. If this switch is not programmed,
radio wide scanning is not available.

* To turn radio wide scanning on, press the Radio
Wide Scan option switch. The Z, icon isthen
displayed continuously and “RWS ON” isdisplayed
briefly on the lower line of the display.

* To turn radio wide scanning off, press the Radio
Wide Scan option switch again. The Z, iconisthen
no longer indicated and “RWS OFF” is displayed
briefly.

¢ |f the zone or channel is changed while radio wide
scanning, scanning continues normally.

Scan Resume Delay

When amessage is received or transmitted while
scanning, there is a programmabl e delay before scan-
ning resumes. The delay after receiving a call prevents
another message from being received before you can
make aresponse, and the delay after transmitting a call
ensures that you hear aresponse to your call instead of
another message occurring on some other channel.

Standard Mode Scan List

NOTE: The selected channel is always scanned.

With conventional operation, up to three scan lists
can be programmed. Thelist that is scanned is selected
by the Scan option switch as described on Section
2.4.11. Selecting another conventional channel does
not change the current scan list. The scan lists are user
programmable if the Scan Edit option switchis
programmed (see “Programming a Scan List” which
follows).

With SMARTNET/SmartZone operation, each
channel can be programmed so that one of up to three
different scan listsis automatically selected or scan-
ning is disabled. The scan lists are user programmable
if the Scan Edit option switch is programmed (see
“Programming a Scan List” which follows).
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Radio Wide Mode Scan List

With radio wide scanning, thereis only one
preprogrammed scan list avail able regardless of the
type of channel selected, and it is not user
programmable.

Determining Which Channels arein Scan List

With standard conventiona scanning, the selected
channel isin the current scan list if the box [ ] icon
(around “S”) isindicated in the upper left corner of the
display. Channelsin SMARTNET/SmartZone stan-
dard scan lists areindicated only when editing a scan
list. Channelsin the radio wide scan list are not
indicated.

Nuisance Channel Delete

With standard scanning, both conventional and
SMARTNET/SmartZone channels can be temporarily
deleted from the scan list. This feature is not available
with radio wide scanning. Proceed as follows:

NOTE: The selected channel and conventional priority
channels cannot be deleted from the scan list.

1. While receiving a message on the channel to be
deleted, press and hold the Scan option switch until
the aert tone sounds (about 1 second).

The channel isthen deleted and scanning of the
remaining channelsin the scan list resumes.

Deleted channels are added back into the scan list if
any of the following occur:

* Scanning isturned off and then on again using the
Scan switch.

* The selected channdl is changed.

* Transceiver power isturned off and then on again.

Programming a Scan List

If the Scan Edit option switch is programmed,
conventional and SMARTNET/SmartZone standard
scan lists can be user programmed as follows:

1. Make sure that both standard and radio wide scan-
ning are off (neither the standard scan “S” icon or
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radio-wide scan Z, icon is displayed). Then press
the Scan Edit option switch to select the scan list
edit mode.

2. With conventional channels, if applicable, select the
list to be edited (1-3) by rotating and then pressing
the Select switch. The selected list isindicated as
“SCAN x”, where“x” isthelist number from 1-3. If
user programming is disabled on alist, “NO LIST”
is momentarily displayed and it cannot be edited.

With SMARTNET/SmartZone channels, the scan
list for the selected channel isfixed and cannot be
changed. Scanning may also be disabled on the
channel in which case “NO LIST” is momentarily
displayed and scan list editing is not available.

3. Sedlect the channel you want to add or delete by
rotating the Select switch. After the last conven-
tional channel in the current zone is displayed, the
first valid channel in the next zone is displayed and
viceversa. SMARTNET/SmartZone lists are
limited to 16 channels. If an attempt is made to add
more than 16, “LIST FULL" isdisplayed and a
channel must be deleted before another can be
added.

4. If the selected channd isin the scan list (scanned),
the box |:| icon (around “S”) isindicated in the
upper left corner of the display. To change the status
of the displayed channel, press the Select switch.

NOTE: The priority channel cannot be deleted (see
“Priority Channel Sampling” description which
follows).

5. To exit this mode and save the changes, press the
Scan Edit option switch again.

2.3.12 CONVENTIONAL AND SMARTNET/
SMARTZONE OPERATION

Introduction

Each selectable channel is programmable for
either conventional or SMARTNET " /SmartZone®
(trunked) operation. For example, Zone 1/Channel 1
could be a conventional channel, Zone 1/Channel 2 a
SMARTNET/SmartZone channel, and so on. More
information on these modes follows.

Conventional Operation

Thisis anon-trunked operation mode which
accesses independent radio channels (there is no auto-
matic access to several channels as with trunked oper-
ation). Monitoring before transmitting may not occur
automatically in this mode, so you may have to manu-
ally monitor the channel before transmitting to make
surethat it is not being used by anyone else (see
Section 2.4.3). Selecting a conventional channel
selects atransmit and receive frequency and other
parameters such as Call Guard sguelch coding.

SMARTNET/SmartZone Operation

Thisis atrunked operating mode that uses ID
codes to select which mobiles are being called and
which calls are received. Monitoring is performed
automatically and special messages and tones indicate
busy and out-of-range conditions. Enhanced features
include roaming (SmartZone only), telephone, private,
and emergency calls, Call Alert, and messaging. Oper-
ating features unique to SMARTNET/SmartZone
channels are described in Section 2.5.

This radio supports only the SMARTNET Il
trunking protocol. It does not support the
SMARTNET | (also referred to as Type ) protocol.
When a SMARTNET or SmartZone channel is
selected or the radio is powered up on one of those
channels, it searches for a control channel and
attempts to register on the radio system. Once a
control channel is found, the alias (name) of the
selected channel is displayed. If a control channel
could not be found (because of an out of range condi-
tion or the system ID is not correct, for example), “NO
SY S’ isdisplayed and the radio continues to search
for acontrol channel.

The control channel transmits and receives
system information to and from al radios registered on
the system. Therefore, once acontrol channel isfound,
it is continuously monitored for incoming call infor-
mation and is used to make call requests. Theradio
automatically changes to atraffic channd to place and
receive calls and then returns to the control channel
when the call is complete.

Revised January 2001
Part No. 001-9800-501



OPERATION

2.4 CONVENTIONAL FEATURES
2.4.1 INTRODUCTION

The following information describes features
unique to the conventional operating mode (described
briefly in Section 2.3.12). Refer to Section 2.3 for
information on features common to all operating
modes, and to Section 2.5 for information on features
unique to the SMARTNET/SmartZone mode.

2.4.2 DISPLAY MODE SELECTION

If the Displayed Information option switch is
programmed, the display mode used to indicate
conventional channels can be user selected. Pressing
this switch cycles between the following modes. The
selected mode does not change when power is turned
off. If the Displayed Information option switch is not
programmed, the Alias mode is always used.

Alias - The preprogrammed al phanumeric tag for
the channel is displayed.

Number - The channel number from 1-16 is
displayed.

Frequency - The receive frequency of the selected
channel is displayed in megahertz.

2.4.3 MONITORING BEFORE TRANSMITTING

With conventional operation, channels are moni-
tored automatically or manually as follows:

Automatic Channel Monitoring

If the selected channel is programmed for the
Busy Channel Lockout feature, monitoring is
performed automatically. Refer to the description of
this feature in Section 2.4.5 for more information.

Manua Channel Monitoring

The automatic monitoring just described may not
be programmed or it may occasionally disable the
transmitter even if the channel isnot in use. In this
case, the channel must be monitored manually as
follows:
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Busy Indicator - With scanning disabled, noteif the
Transmit/Busy indicator on the front panel is green.
If itisnot, the channel is not being used and the call
can be transmitted. If itison, acarrier isbeing
detected, so the channel may be busy (see next

paragraph).

Monitor Mode - There may be times when the busy
indication is displayed even though no oneis using
the channel. Monitoring should then be performed
by disabling Call Guard squelch by taking the
microphone off-hook (if off-hook detection is
enabled), pressing the Normal/Sel ective switch as
described in on Section 2.4.6, or by selecting the
monitor mode as described next.

2.4.4 MONITOR MODE

The monitor mode temporarily disables squelch
control features (such as Call Guard® sguelch) so that
all messages are heard on the selected channdl. It also
overrides the Busy Channel Lockout feature (see next
section) and temporarily disables scanning.

To monitor the selected channel, salect the
monitor mode by briefly pressing the MON option
switch (if available). The ‘ icon isdisplayed and the
receiver unsguelches when the monitor modeis
enabled. To disable the monitor mode and return to
normal operation, press the MON switch a second
time.

When scanning is enabled, pressing and holding
the MON option switch until atone sounds (approxi-
mately 1 second) monitors the scanned channel instead
of the selected channel.

2.4.5 BUSY CHANNEL LOCKOUT

The Busy Channel Lockout feature (also called
Transmit Disable On Busy) automatically disables the
transmitter if the channel is busy when the PTT switch
is pressed. When a busy condition is detected by this
feature, the transmitter is disabled, “BUSY” isindi-
cated on the lower line of the display, and atone
similar to a standard telephone busy tone sounds until
the PTT switch isreleased. Thisfeatureis
programmed to operate in one of the following modes
on each channel:
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Off - Thetransmitter keys even if the channd is busy.

Noise - The transmitter isdisabled if any signal is
detected on the channel.

Tone - The transmitter is disabled if the detected
sguelch coding is not correct.

If busy override is permitted by programming, it
is possible to transmit even when the transmitter is
disabled by thisfeature. Simply release the PTT switch
and then quickly pressit again.

2.4.6 CALL GUARD SQUELCH
General

Call Guard® squelch (also called CTCSS/DCS
signaling) may be programmed on conventional chan-
nels. This feature eliminates distracting messages
intended for others using the channel by using a
subaudible tone or digital code to control the squelch.
Thistone or code is unique to a user or talk group on
that channel. It is transmitted by the mobile placing a
call, and if Call Guard squelch is programmed in the
mobile receiving the call, it must detect the correct
tone or code to receive the call.

Cadll Guard Squelch Enable/Disable

To disable Call Guard (Selective) squelch so that
all messages on the selected or scanned conventional
channels are heard, take the microphone off-hook (if
off-hook detection is enabled) or press the Normal/
Selective option switch if programmed. Then to re-
enable Call Guard squelch, place the microphone back
on-hook or press the Normal/Sel ective switch again.

When Call Guard squelch is disabled by the
option switch, “SQ NORM” is flashed on the lower
line of the display, and when it is enabled, “SQ SLCT”
is flashed. The mode selected by this switch does not
change when other channels are selected or power is
cycled. Call Guard squelch can also be disabled by the
monitor mode described in Section 2.4.4.

2.4.7 PENALTY TIMER

A penalty timer may be programmed on conven-
tional channelsto prevent transmissions for atime
after the time-out timer described in Section 2.3.7
disables the transmitter. The penalty timer starts when

the PTT switch is released after the transmitter has
been disabled. If the PTT switch is pressed during the
penalty time, the time-out indication occurs again. A
beep sounds when the penalty timer expires and the
transmitter can then be keyed.

2.4.8 CONVERSATION TIMER

A conversation timer can be programmed on
conventional channelsto limit the total length of a
conversation rather than just the length of each trans-
mission as with the time-out timer. Thistimer is reset
when the time between transmissions exceeds the
penalty time just described. A warning tone sounds 5
seconds before the conversation timer expires. When it
expires, the transmitter is disabled and awarning tone
sounds. The transmitter remains disabled for the
length of the penalty time, and a beep sounds when it
can be keyed again.

2.4.9 REPEATER TALK-AROUND

Normally, al transmissions go through a repeater
which usually increases range. However, if out of
range of the repeater, you cannot talk to anyone else
on that channel even though the mobile you are calling
may be only a short distance away. To allow commu-
nication when this situation occurs, repeater talk-
around can be used to allow direct communication
with amobile without going through a repesater.

Repeater talk-around can be selected if the
Repeater Talk-Around option switch is programmed.
When talk-around is enabled by this switch, the A
iconisdisplayed and “RTA ON” is flashed on the
lower line of the display. Then when it is disabled by
pressing the switch again, that icon is no longer
displayed and “RTA OFF" isflashed. Changing chan-
nels or turning power off does not change the selected
talk-around mode.

2.4.10 POWER OUTPUT SELECT

If the High/L ow Power option switchis
programmed and power selection is permitted on the
current channel by programming, either high or low
transmitter power can be selected. Pressing this switch
toggles the power setting. The new level isflashed on
the lower line of the display when this switch is
pressed as “HI POWER” or “LO POWER". If power
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selection is not permitted on the current channel, the
fixed power level isflashed and no power change
occurs. Turning power off or changing channels does
not change the power setting selected for a channel.

2.4.11 CONVENTIONAL MODE SCANNING
General

The following information describes scanning
features unique to conventional operation. Scan opera-
tion common to all modesis described in Section
2.3.11, and scan operation unique to SMARTNET/
SmartZone operation is described in Section 2.5.12.

Selecting a Scan List

With conventional standard scanning, one of up
to three scan lists can be selected. Scanning is turned
on and off and the scan list selected by repeatedly
pressing the Scan switch as follows:

1. Pressthe Scan option switch once to enable scan-
ning and Scan List 1. The“S” iconisthenindicated
inthe upper left corner of thedisplay and“ SCAN 1”
is momentarily displayed on the bottom line.

2. Pressthe Scan option switch again to select Scan
List 2 (if available), and “SCAN 2" is momentarily
displayed. Pressit again to select Scan List 3 (if
available).

3. Pressing the Scan option switch again disables scan-
ning (the “S” icon is no longer displayed). If the
Scan option switch is pressed again, the cycle
repeats.

Transmitting in Scan Mode

Each conventional scan list can be programmed
for one of the following modes. These modes deter-
mine if priority sampling occurs and a so the channel
on which transmissions occur while scanning. Refer to
the next section for more information.

No Priority - No priority channel sampling occurs
when the list is selected. The radio transmits on the
selected channel.

Priority/Tx Priority - Priority sampling occurs and
the priority channel is the one programmed in the
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selected scan list. The radio transmits on the priority
channel.

Priority/Tx Selected - Priority sampling occurs and
the priority channel is the one programmed in the
selected scan list. The radio transmits on the selected
channel.

Priority on Selected - The priority channel is always
the selected channel. The radio transmits on the
selected channel.

Talkback - No priority sampling occurs. The radio
transmits on the channel of acall while scanning is
hated. Then once scanning resumes, it transmits on
the selected channel.

2.4.12 PRIORITY CHANNEL SAMPLING
Generd

The priority channel sampling feature ensures
that when standard scanning, messages on the priority
channel are not missed while listening to amessage on
some other channel. The transceiver can be
programmed so that the priority channel isafixed
channel associated with the current scan list, the
currently selected channel, or not used. When the
selected channel isa priority channel, “ P” isindicated
in the upper right part of the display.

Priority channel sampling occurs only with Stan-
dard conventional scanning. It does not occur with
Radio Wide scanning, when listening to any type of
SMARTNET/SmartZone call, or when transmitting. A
series of “ticks” may be heard when the priority
channel is sampled while listening to a message on
some other channel.

The priority sampling times are programmed by
the following parameters:

Lookback TimeA - Thistime determines how often
the priority channel is checked for activity. Times of
0.25-4.00 seconds in 0.25-second steps can be
programmed.

Lookback Time B - Thistime determines how often
the priority channel is checked once an incorrect Call
Guard (CTCSS/DCS) codeis detected. Since it takes
much longer to detect an incorrect Call Guard signal
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than a carrier, thistime should be relatively long to
prevent the interruptions from making a message diffi-
cult to understand. Times of 0.5-8.0 seconds can be
programmed in 0.5-second steps.

Changing The Priority Channel

If aspecific priority channel is associated with
the current scan list, it can be changed if the Priority
option switch is programmed. Proceed as follows:

1. Make sure all scanning is off (neither the standard
scan “S” icon or radio-wide scan Z, icon is
displayed).

2. Sdlect the channel that you want to be the priority
channel using the Select switch in the normal
manner. If the channel isin adifferent zone, also
select the appropriate zone.

3. Pressthe Priority option switch and the “P” iconis
displayed to indicate that the selected channel is
now the priority channel.

2.4.13 STANDARD CONVENTIONAL CALLS

Standard conventional calls are callsto or from
other mobile units on the selected channel. The proper
coded Call Guard signaling (see Section 2.4.6) may
need to be transmitted for them to receive your call
and also for you to receive their calls. Proceed as
follows to place and receive these calls:

Placing a Standard Conventiona Call

1. Turn power on and set the volume as described in
Section 2.3.2. Select the channel programmed for
the mobile you want to call (see Section 2.3.5).

2. Monitor the channel automatically or manually as
described in Section 2.4.3.

3. Pressthe PTT switch and the call proceeds as
follows:

¢ |f the Busy Channel Lockout featureis
programmed on the channel, the transmitter is
automatically disabled if the channel is busy (see
description in Section 2.4.5).

* Otherwise, busy and out-of-range conditions are
not indicated and speaking can begin after moni-
toring the channel.

4. Press (and hold) the PTT switch to talk and release
it to listen.

Receiving a Standard Conventional Cal

1. Select or scan the channel programmed for the call
you want to receive (refer to Sections 2.3.11 and
2.4.11 for more scanning information).

2. Whenthe call isreceived, pressthe PTT switch to
talk and release it to listen. If scanning, you may
have to respond before scanning resumes to ensure
that the response occurs on the channel of the call.

2.4.14 DTMF/ANI SIGNALING

DTMF (Dual Tone Multi-Frequency) tones can
be generated manually or automatically for ANI
(Automatic Number Identification) and other
purposes. The following options may be enabled by
programming for each conventional channel:

DTMF Keypad - Pressing 0-9, *, or # on the keypad

of an optional DTMF microphone transmits the corre-
sponding tone (the PTT switch must also be pressed if
the transmitter does not automatically turn on when a
key is pressed).

Pre-Tx ANI - A preprogrammed ANI sequenceis
automatically sent when you pressthe PTT switch.

Post-TX ANI - A preprogrammed ANI sequenceis
automatically sent each time you release the PTT
switch.

Disabled - ANI signaling is disabled.

2.5 SMARTNET/SMARTZONE FEATURES
2.5.1 INTRODUCTION

The following information describes the features
unigue to the SMARTNET/SmartZone operating
mode described briefly in Section 2.3.12. Features
common to all operating modes are described in
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Section 2.3, and features unique to the conventional
mode are described in Section 2.4.

2.5.2 VIEWING UNIT ID

EachradioinaSMARTNET system isidentified
with asystem ID and Unit ID. To display the Unit ID,
make sure that a SMARTNET/SmartZone channel is
selected and then turn power off and then on again.
The software version number, current zone, and six-
digit Unit ID are then displayed in sequence. The Unit
ID isdisplayed as | DXXXXXX.

2.5.3 STANDARD GROUP CALLS

Standard calls are between you and another
mobile, group of mobiles, or a control station (aradio
at afixed location). Most calls you make will probably
be thistype.

Placing a Standard Group Call

1. Turn power on and set the volume as described in
Section 2.3.2. Select the channel programmed for
the talk group you want to call (see Section 2.3.5).
A regular or announcement talk group can be
selected.

2. Pressthe PTT switch and when the alert tone
sounds, begin talking. Other indications that may
occur are as follows;

* |f the busy tone soundsand “BUSY” isdisplayed,
the system is busy. Release the PTT switch and
wait for the call back toneto sound. Then pressthe
PTT switch within 3 seconds and begin talking.

¢ |f acontinuous tone sounds while pressing the
PTT switch, an out-of-range condition may exist.
Drive closer or away from shielding objects and

try again.

¢ |f yourunitID isinvalid, thecall isbeing madeto
aninvalidgroup 1D, or group callsare not allowed,
“INVALID ID” isdisplayed and an alert tone
sounds.

Recelving a Standard Call

When a SMARTNET/SmartZone group call is
received, the transceiver can be programmed to
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display either the talk group of theincoming call or the
ID of the radio making the incoming call. If the ID is
in the Trunking Call List, the alias of that mobileis
displayed instead of the ID. If neither of these features
are programmed, the alias of the selected talk group
continues to be displayed when a call is received.

2.5.4 ENHANCED PRIVATE CONVERSATION
CALLS

General

Private calls alow you to place acall to aspecific
mobile unit. Either the Enhanced Private Conversa-
tion"" or Private Conversation 11" modes may be
programmed depending on the capabilities of the radio
system. Operation in the Enhanced Private Conversa-
tion mode is described in the following information,
and operation in the Private Conversation || modeis
described in Section 2.5.5.

The Private Call option switch isrequired to
place these calls, and either that switch or the Call
Response option switch isrequired to receive them.
Proceed as follows.

Placing an Enhanced Private Conversation Call

Thiscall isinitiated by selecting the unit ID from
acal list (list entry) or by directly entering it using the
microphone keypad (direct entry). Proceed as follows:

List Entry Method

1. Witha SMARTNET/SmartZone channel selected,
momentarily press the Private Call option switch.
Theprivatecall modeisthenindicated by “C” inthe
upper part of the display. Then if thelast ID called
matchesan ID inyour call list, itisdisplayed on the
lower line and the name is displayed on the upper
line. Otherwise, only thelast ID called is displayed.

2. Scroll through the private call list by rotating the
Select switch until the desired ID isdisplayed. To
cancel the call, press the Private Call switch.

3. Pressthe PTT switchtoinitiatethecall. The display
then indicates the alias of the destination radio.
Proceed to the bulleted list following the next
method for conditions that may occur next.
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Direct Entry Method (With DTMF Microphone Only)

1.

With a SMARTNET/SmartZone channel selected,
press and hold the Private Call option switch until a
tone sounds (approximately 1 second). Thelast ID
called isdisplayed on the upper line, and the private
call modeisindicated by “C” inthe upper part of the

display.

Using the 0-9, #, and * keys, enter the 6-digit ID of
the mobile unit you are calling. To erase the last
digit entered, rotate the Select switch counterclock-
wise, and pressthe Private Call switch to cancel the
call.

Pressthe PTT switch to initiate the call. If the
entered ID isinvalid, “INVALID” is momentarily
displayed and the call is not initiated. If the entered
ID isvalid, the alias of the ID is displayed on the
lower lineif it matchesan ID inyour call list. Other-
wise, only the ID you entered continues to be
displayed. Any of the following conditions may
then occur:

If theradio you are calling is on the air, telephone
type “ringing” is heard for 20 seconds or until the
called party answers.

If the called party answers and the call is
successful, the person’svoiceis heard and the call
is carried on the same as a group call. To end the
call at any time, press the Private Call switch.

If the called party does not answer within 20
seconds, “NO ANSWR” isdisplayed and acontin-
uous tone sounds. End the call by pressing the
Private Call switch.

If the called radio is not in service, no ringing is
heard, “NO ACK” isdisplayed, and a continuous
tone sounds. End the call by pressing the Private
Call switch.

If neither your radio nor the radio being called is

authorized to make unit-to-unit calls, “NO ACK”

isdisplayed and acontinuoustone sounds. End the
call by pressing the Private Call switch.

If the called party answers but the radio systemis
busy, four low tones sound and “BUSY” is
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displayed. When the system is no longer busy, the
called party automatically responds.

¢ |f an out-of-range condition exists or the radio
systemisnot in service, “NO SYS” isdisplayed
and a continuous tone sounds. End the call by
pressing the Private Call switch.

Receiving an Enhanced Private Conversation Call

This call is automatically received if a
SMARTNET/SmartZone channel is selected. Proceed
asfollows:

1. Whenthiscall isreceived, arecurring unit call tone
(three beeps) sounds for up to 20 seconds and
“CALL RCV” isdisplayed on the lower line.

2. To answer the call, press the Private Call option
switch and then the PTT switch and begin talking.
The private call modeisindicated by “C” in the
upper part of the display, and the alias of the
incoming call is displayed if the ID isin your call
list. Otherwise, the unit ID isdisplayed. NOTE: If
the Private Call option switch is not pressed before
the PTT switch, a group call istransmitted on the
selected group.

* To end the call when the conversation is complete
or at any other time, press the Private Call switch.

* |f private calls are not permitted (Private Call
switch not programmed), press the Call Response
option switch, if available, to answer the call.

* |f thecall is not answered within 20 seconds, it is
automatically terminated.

¢ |f theradio system is busy, four low tones sound
and “BUSY” isdisplayed. When the system isno
longer busy, the call back tone (four beeps) is
heard and your radio automatically starts transmit-
ting. Pressthe PTT switch to continue the call.

* Toignoreanincoming call, wait 20 seconds until
the recurring unit call tone stops sounding.
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2.5.5 PRIVATE CONVERSATION Il CALLS
General

Private callsalow you to place acall to aspecific
mobile unit. Either the Enhanced Private Conversa-
tion™ or Private Conversation 11™ modes may be
programmed depending on the capabilities of the radio
system. Operation in the Enhanced Private Conversa-
tion mode is described in Section 2.5.4, and operation
in the Private Conversation |1 mode is described in the
following information.

The Private Call option switch is required to
place these calls, and either the Private Call or Cal
Response option switch is required to receive them.
Proceed as follows.

Placing a Private Conversation |1 Call

Thiscall isinitiated by selecting the unit ID from
acall list (list entry) or by directly entering it using the
microphone keypad (direct entry). Proceed as follows:

List Entry Method

1. WithaSMARTNET/SmartZone channel selected,
momentarily press the Private Call option switch.
The private call mode isindicated by “C” in the
upper part of the display, and the alias (name) of the
last ID calledisdisplayedif it matchesan ID in your
call list. Otherwise, thelast ID called is displayed.

2. Scroll through the private call list by rotating the
Select switch until the desired ID isdisplayed. Press
the Private Call switch again to cancel the call.

3. Pressthe PTT switchtoinitiatethecall. The display
then indicatesthe alias of the destination radio. Wait
approximately 1 second and then begin talking.
Proceed to the bulleted list following the next
method for conditions that may occur next.

Direct Entry Method (With DTMF Microphone Only)

1. WithaSMARTNET/SmartZone channel selected,
press and hold the Private Call option switch until a
tone sounds (approximately 1 second). Thelast ID
called isdisplayed on the upper line, and the private
call modeisindicated by “C” inthe upper part of the

display.

Revised January 2001
Part No. 001-9800-501

2. Using the 0-9, #, and * keys, enter the 6-digit ID of
the mobile unit you are calling. To erase the last
digit entered, rotate the Select switch counterclock-
wise, and press the Private Call switch to cancel the
cal.

3. Pressthe PTT switch to initiate the call. If the
entered ID isinvaid, “INVALID” is momentarily
displayed and the call is not initiated. If the entered
ID isvalid, the alias of the ID is displayed on the
lower lineif it matchesan ID inyour call list. Other-
wise, only the ID you entered continues to be
displayed. Wait approximately 1 second and begin
talking. Any of the following conditions may then
occur:

* |f the called party answers and the call is
successful, the person’svoiceis heard and the call
is carried on the same as a group call. To end the
call at any time, press the Private Call switch.

¢ |f theradio system is busy, four low tones sound
and “BUSY” isdisplayed. When the system isno
longer busy, the call back tone (four beeps) is
heard and a channel is automatically acquired.
Pressthe PTT switch to continue the call.

Receiving a Private Conversation |1 Call

Private calls are automatically received if a
SMARTNET/SmartZone channel is selected. Proceed
as follows:

1. Whenacall isreceived, an aert tone sounds and the
cdler’'svoiceisheard. Whilevoiceisheard, “C” is
indicated inthe upper part of thedisplay and“ CALL
RCV"” isdisplayed and the lower line of the display.

2. To answer the call, press the Private Call option
switch and then the PTT switch and begin talking.
The private call mode isindicated by “C” in the
upper part of the display, and the alias of the
incoming call is displayed if the ID isin your call
list. Otherwise, the unit ID is displayed. NOTE: If
the Private Call option switch is not pressed before
the PTT switch, a group call istransmitted on the
selected group.

* To end the call when the conversation is complete
or at any other time, press the Private Call option
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switch again. If the call is not answered within 20
seconds, it is automatically terminated.

If private calls are not permitted (Private Call
switch not programmed), press the Call Response
option switch, if available, to answer the call.

2.5.6 TELEPHONE CALLS

General

Telephone calls allow you to place and receive
calls over the public telephone system using your
transceiver. If your transceiver is programmed for tele-
phone calls (Phone option switch programmed), they
are placed and received as follows:

Placing a Telephone Call

Telephone calls can be placed by selecting the
number from a preprogrammed phone number list (list
entry) or by directly entering it using the microphone
keypad (direct entry). Proceed as follows:

List Entry Method

1. WithaSMARTNET/SmartZone channel selected,
momentarily press the Phone option switch. The
phone mode is indicated by the g icon, and the
display indicates the alias of the last called tele-
phone number if it isin your phone number list.
Otherwise, the last called telephone number is

displayed.

Scroll through the list of telephone numbers by
rotating the Select switch until the desired number is
found. Pressthe Phone option switch again to cancel
the call.

Pressthe PTT switch to initiate the call. The display
indicates“DIALING” while the connection to the
phone system is occurring. Once connected, the
normal dial toneisheard and the alias of the number
being called isagain displayed. The radio then auto-
matically dial sthetel ephone number and the normal
ringing or busy toneisheard. Proceed to the bulleted
list following the next method for conditions that
may occur next.
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Direct Entry Method (With DTMF Microphone Only)

1. Witha SMARTNET/SmartZone channel selected,
press and hold the Phone option switch until atone
sounds (approximately 1 second). The last phone
number called is displayed, and the phone mode is
indicated by the #g¥ icon.

Enter the number usingthe 0-9, % , and# keys. To
enter apause (indicated by “P"), press % andthen
#. The number scrollsto the left in the display so
that the seven right-most digits are always
displayed. Numbers up to 16 digits (including
pauses) can be entered. To erase the last digit
entered, rotate the Select switch counterclockwise,
and press the Phone switch to cancel the call.

Pressthe PTT switch to initiate the call. The display
indicates“DIALING” while the connection to the
phone system is occurring. Once connected, the
normal dial toneisheard and the alias of the number
being called isagain displayed. Theradio then auto-
matically dialsthetelephone number and the normal
ringing or busy tone is heard. Any of the following
conditions may then occur.

After the called party answers, pressthe PTT
switch to talk and release it to listen. You cannot
talk and listen at the same time because the radio
cannot transmit and receive at the sametime. Each
timethe PTT switchisreleased, atoneisheard by
the other party that indicates when aresponse can
be made. To end the call when the conversation is
complete or at any other time, press the Phone
option switch again.

If equipped with an optional DTMF microphone, a
number can be dialed during acall.

If an out-of-range condition exists or the radio
systemisnotin service, “HANG UP" isdisplayed
and a continuous tone sounds. End the call by
pressing the Phone option switch.

If you are not authorized to make telephone calls,
“REJECT” is displayed and a continuous tone
sounds. End the call by pressing the Phone option
switch.
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If the radio system is busy, “BUSY” is displayed
and a busy tone sounds. The call automatically
proceeds when the radio system becomes avail -
able. If the call is ended before it proceeds, your
position in queueislost.

Answering a Telephone Call

Telephone calls are automatically received if a
SMARTNET/SmartZone channel is selected. Proceed
asfollows:

1. When atelephonecall isreceived, “ringing” similar
to a standard telephone is heard, and the display
indicates “PHONE”" on the bottom line.

To answer the call, press the Phone option switch
and the phone mode is indicated by the g icon.
Pressthe PTT switch to talk and release it to listen.

To end the call when the conversation iscompl ete or
at any other time, press the Phone option switch

again.
2.5.7 CALL ALERT

The Call Alert™ feature allows pages to be sent
and received asfollows:

Sending a Page

1. With aSMARTNET/SmartZone channel selected,
momentarily pressthe Call Alert option switch. The
tag (alias) of thelast ID called isdisplayed if it
matches an ID in your call list. Otherwise, the last

ID called is displayed.

To select the desired ID, rotate the Select switch to
scroll through theID list. Pressthe Call Alert option
switch again to cancel the call.

Pressthe PTT switch to send the page. The display
then indicates the alias of the radio being paged.
Conditions that may then occur are as follows:
¢ |f theradio you are paging ison the air and
received your page, a signaling success tone (six
beeps) sounds and the display momentarily indi-
cates“ACK RCVD” onthe bottom line. The alias
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of the selected channel is then displayed
continuously.

If theradio you are paging isnot in service, atone
soundsand“NO ACK" isdisplayed. Pressthe Call
Alert switch again to cancel the page.

Answering a Page

1. Whenapageisreceived, “PAGE RCV” isindicated
on the bottom line and a recurring received page

tone (six beeps) sounds.

Answering a page is the same as placing a private
call. Therefore, pressthe Private Call option switch
and follow the instructions for placing aprivate call
in Section 2.5.4 or 2.5.5, whichever is applicable.

2.5.8 MESSAGING

The messaging feature allows preprogrammed
messages to be sent to your dispatcher. Up to 16
messages can be preprogrammed, and they are identi-
fied by dias (name). If a Message option switchis
programmed, messages are sent as follows:

1. Momentarily press the Message option switch. The
alias of the last message sent is displayed.

Scroll through the messagelist by rotating the Select
switch until you find the desired message. Pressthe
M essage option switch again to cancel the message.

Pressthe PTT switch to send the message. When the
message is received and acknowledged by the
dispatcher, a signaling success tone (six beeps)
soundsand thedisplay returnsto the normal channel
indication. If there is no acknowledgment after 6
seconds, atonesoundsand “NO ACK” isdisplayed.
Press the M essage option switch again to return to
normal operation.

2.5.9 SENDING STATUS CONDITIONS

The status feature allows you to send your current
status to a dispatcher. Up to eight status conditions can
be preprogrammed, and they are identified by an alias
(name). If the Status option switch is programmed,
status conditions are sent as follows:



OPERATION

1. Momentarily pressthe Status option switch, and the
adlias of the last status sent is displayed.

2. To change the displayed status, scroll through the
status list by rotating the Select switch. Press the
Status option switch again to cancel this function.

3. Pressthe PTT switch to send the status. When the
message is received and acknowledged by the
dispatcher, a signaling success tone (six beeps)
soundsand the display returnsto thenormal channel
indication. If there is no acknowledgment after 6
seconds, atone soundsand “NO ACK” isdisplayed.
Press the Status option switch again to return to
normal operation.

2.5.10 EMERGENCY ALARM AND CALL
Introduction

Emergency Alarms and Emergency Calls are
separate functions that can be individually enabled or
disabled on each SMARTNET/SmartZone system.
The Emergency option switch is also required for
these functions, and it is aways the button to the left
of the display when it is used. Emergency Alarms and
Cdlls are transmitted on the emergency talk group
programmed on the selected system.

Emergency Alarms

An emergency alarm is a special data transmis-
sion that alerts a dispatcher of an emergency situation.
Proceed as follows to activate an emergency alarm:

1. Select aSMARTNET/SmartZone channel that has
this feature enabled and then press the Emergency
option switch. The radio then begins automatically
transmitting an emergency alarm data message and
“EMERGNCY” isindicated in the display for 3
seconds.

2. When the emergency alarm is acknowledged, the
emergency acknowledge tone (two beeps) sounds.
Silent operation may also be programmed in which
case no tone sounds and there is no indication that
an acknowledgment occurred.

3. Theradio continuesto transmit thismessageuntil an
acknowledgment is received or the programmed

number of attempts have been made. To exit this
mode, power must be turned off and then on again.

Emergency Calls

An emergency call urgently requests accessto a
voice channel. To place this call, proceed as follows:

1. Select aSMARTNET/SmartZone channel that has
thisfeature enabled and pressthe Emergency option
switch. The emergency mode is indicated when
“EMERGNCY” isindicated in the display for
3 seconds.

2. To place the emergency call, manually pressthe
PTT switch and begin speaking as with a standard
call. All group calls which follow are then emer-
gency calls (private, telephone, and call alert calls
are not allowed). If the channel is changed, the call
is made on the emergency talk group programmed
for the new channel.

3. Toexitthismode, power must beturned off and then
on again.

2.5.11 FAILSOFT OPERATION

If afailure occursin the SMARTNET/Smart-
Zone system so that it cannot be used, the transceiver
automatically enters the fail soft mode. When this
mode is selected, “FAILSOFT” isindicated on the
lower line of the display.

When in the failsoft mode, operationisin the
conventional mode on a preprogrammed fail soft
channel. If atransmission is attempted before afail soft
channel islocated, a continuous tone sounds until the
PTT switch isreleased. When the radio system returns
to normal operation, this condition is automatically
detected and normal operation resumes.

2.5.12 SMARTNET/SMARTZONE SCANNING

Scanning on a SMARTNET/Smartzone channel
issimilar to the standard and radio wide scanning
described starting in Section 2.3.11. Each channel can
be programmed with a different scan list that includes
up to 16 channels, one of which can be a priority
channel. Up to three lists can be programmed, and
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they are user programmableif the Scan Edit option
switch is programmed (see “Programing a Scan List”
in Section 2.3.11).

Scanning is enabled/disabled by the Scan option
switch. In addition, channels can be programmed so
that scanning automatically starts whenever the
channel is selected. Scanning is temporarily disabled
and “S” turns off if achannel is selected that has scan-
ning disabled. Then when a channd is selected again
that permits scanning, it is automatically re-enabled.

When responding to messages in the scan maode,
programming determines if the response aways
occurs on the talk group of the call or the selected talk
group (if they are different). Transmissions occurring
at other times always occur on the selected talk group.

In addition to calls on channelsin the scan list,
pages, private calls, and telephone calls are received
while scanning. M essages on the priority channel are
received while listening to lower priority messages.
However, private and telephone calls are not inter-
rupted by calls on the priority channel.

2.5.13 DYNAMIC REGROUPING

The dynamic regrouping feature allows a
dispatcher to switch usersto a dynamically defined
channel to receive an important message. Dynamic
regrouping operates as follows:

1. When this command is received, the alternating
dynamic regrouping tone sounds, the transceiver
automatically changes to the regrouping channel,
and thedisplay indicates* REGROUP’ on thelower
line. All transmitting and receiving then occurs on
this channel.

Toreset al talk and announcement groupsto normal
so that only the designated regrouping channdl ison
the dynamic group, manually select the designated
regrouping channel if you know it. If thischannel is
not selected or there is no designated regrouping
channel, all transmissions occur on the dynamically
assigned group regardless of which channel is
selected, and the regrouping tone sounds each time
the PTT switch is pressed.
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3. When regrouping is canceled by the dispatcher,
transceiver operation returnsto normal.

2.5.14 SMARTZONE FEATURES
Introduction

Asdescribed in Section 2.3.12, the SmartZone®
mode provides wide area coverage by allowing
roaming between SMARTNET and conventional sites.
SmartZone operation is the same as SMARTNET with
the following additional features:

Determining Current Site

To determine the current radio site, momentarily
press the Site Search option switch (if programmed). If
currently registered on asite, “SITE x” isdisplayed on
the top line, where “x” isthe site number. If the siteis
locked (see following), “LOCK x” isdisplayed
instead. The RSSI (Receive Signal Strength Indicator)
value of the current site as“RSSI x” is displayed on
the bottom line as“RSSI x”. To exit, press the Site
Search switch again.

Searching For aNew Site

Press the Site Search option switch as described
above. Then to scroll through the other programmed
sites, rotate the Select switch while“SITE x” or “RSS
X" isdisplayed. To select the displayed site, press the
Site Search option switch. To exit thismode and return
to normal operation, press the Site Search switch
again. If sitelock ison when site search is entered (see
following), the radio will be locked on the new site
when this function is exited.

Locking/Unlocking a Site

It is sometimes desirable to stay on the current
site regardless of signal level. To lock the radio on the
current site so that it does not search for another, press
the Site Lock option switch (if programmed). The
display then momentarily indicates “LOCK x” to indi-
cate that the current siteislocked (“x” isthe current
site number). To unlock the site, press the Lock switch
again and “UNLOCK” is momentarily displayed.



OPERATION

When locked on a site, it is till possible to search
for adifferent site using the site search function
described in the preceding section. When anew site is
found, the radio is then locked on that site.

2.6 SUPERVISORY TONES

Single Beep (Alert Tone)

* Power was turned on and a successful power-up
sequence occurred (Section 2.3.2).

* Thetime-out timer is about to expire or the penalty
timer has expired (Sections 2.3.7 and 2.4.7).

* The conversation timer is about to expire (Section
2.4.8).

* Thesystemreceived your page but the paged mobile
isnot on the air (Section 2.5.7).

* Telephone interconnect is not operational (Section
2.5.6).

Continuous Tone (Invalid or No Acknowledge

Condition)

* A transmission is being attempted on an unpro-
grammed channel or a conventional channel
programmed as receive-only.

* The transmitter is disabled by the busy channel
lockout feature (Section 2.4.5).

* Thetransmitter has been disabled by the time-out
timer feature (Section 2.3.7).

* Thetransmitter has been disabled by the conversa-
tion timer (Section 2.4.8).

* An out-of-range condition exists (SMARTNET/
SmartZone only).

* Atransmissionisbeingattempted beforethe penalty
timer has expired (Section 2.4.7).

* Dynamic regrouping has been exited but the
dynamic regrouping channel is still selected
(Section 2.5.13).

* The paged mobile did not acknowledge the page
(Section 2.5.7).

* The message that was sent has not been acknowl-
edged (Section 2.5.8).

® The status condition that was sent has not been
acknowledged (Section 2.5.9).

Single Short Medium-Pitch Tone

¢ A valid key has been pressed.

Single Short L ow-Pitch Tone

¢ Aninvalid key has been pressed.

Six Beegps (Recurring)

* The page was received (Section 2.5.7).

Three Beeps (Recurring)

* A unit-to-unit call was received (Section 2.5.4).

Six Begps

* The paged radio received the page and acknowl-
edged it (Section 2.5.7).

* The message that was sent has been received and
acknowledged (Section 2.5.8).

* Thestatus condition that was sent has been received
and acknowledged (Section 2.5.9).

Two Beeps

* Theemergency alarm condition was acknowledged
(Section 2.5.10).

Gurgle-Like Tone

Dynamic regrouping has occurred (Section 2.5.13).
* Dynamic regrouping has occurred but the
regrouping channel is not selected (Section 2.5.13).

Four Low Tones (Busy Signal)

* Theradio system isbusy or abusy condition exists
when making atelephone call.

Four Alternating High and L ow Tones

* A channel isavailable after abusy condition
occurred (SMARTNET/SmartZone only).
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SECTION 3 PROGRAMMING

Remote Programming Interface (RPI)
Part No. 023-9800-000

Programming Cable
Part No. 597-2002-200

/

To
Battery To
Ign Sense
"""" To

2 Antenna

Figure 3-1 Programming Setup

3.1 GENERAL
3.1.1 PROGRAMMING SETUP

The following items are required to program the
transceiver and control unit. The part numbers of this
equipment are shown in Table 1-1 in Section 1. The
programming set-up is shown above.

* IBM® PC or compatible personal computer

¢ Remote Prog. Interface (RPI) P.N. 023-9800-000

* Cablesfrom the RPI to the computer and
transceiver

¢ E.F. Johnson PCTrunk programming software.

3.1.2 COMPUTER DESCRIPTION

The computer used to run this program should
meet the following minimum requirements:

e Windows® 3.1, 95/98, or NT 3.51 (Windows NT/
2000 is supported only by PCTrunk Version 5.10.0
or later)

* Intel® 486 processor or equivalent

¢ Atleast4 MB of RAM

3-1

* A hard disk drive with at least 5 MB of free space
* A CD-ROM drive
* Anavailable serial port

NOTE: Wth the descriptions which follow, it is
assumed that you have a basic under standing of how
to use your Windows-based operating system. If you
are not familiar with some of the Windows functions
described, refer to your Help Screens and manuals
included with your Windows software.

3.1.3 PCTRUNK SOFTWARE INSTALLATION

The PCTrunk software is supplied on a CD-
ROM. Install this software as follows:

1. Make surethat there are no other Windows applica-
tions open during this installation procedure. Also,
make sure that the computer meets the minimum
requirements listed in the preceding section.

2. Insert PCTrunk CD-ROM in the CD drive of your
computer.
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3. Windows 3.1 - In the Program Manager, double
click the SETUPEXE file on the CD-ROM or click
that file name and select File > Run.

Windows 95/98/NT - In the bottom left corner of
the screen, sdlect Start > Run and then click the
Browse button in the window that is displayed.
Then in the “Look In:” pull-down menu, select the
CD-ROM drive and the file “ Setupxx.x.exe”. Click
the open button and then from the Run window,
click OK and the installation process begins. (The
“xx.X" in the filename is the version of PCTrunk
being loaded.)

4. Follow theinstructions displayed by the setup
program. The default directory for the programis
\Program Files\PCTrunk. If you wish to use some
other directory, click Browse and select it or typethe
name.

3.1.4 CONNECTING RPI TO COMPUTER AND
TRANSCEIVER

RPI Information

The RPI provides the required interface between
the computer and transceiver. It converts the RS-232
logic levels from the computer to the TTL logic levels
required by the transceiver microprocessor and vice
versa,

A new RPI (Part No. 023-9800-000) has been
designed for thistransceiver. This RPI is backward
compatible, so it can also be used to program other
E.F. Johnson transceiverswhich require an RPI (except
the 5300 series). This new RPI isrequired to Flash
program the transceiver to update the logic board oper-
ating software, and it has a phone jack that is required
for injecting the transmit audio signal during align-
ment. To perform the standard personality program-
ming described in most of this section, earlier RPI's
such as Part No. 023-5810-000 or 023-9750-000 can
also be used.

When programming both front and remote models
of this transceiver, the switch on the front panel of the
RPI selects either the standard or Flash programming
mode. The standard mode is selected when it is away
from the LED and the indicator is green, and the Flash
mode is selected when it is toward the LED and the
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indicator is amber. The standard mode should be
selected for all but Flash programming.

With some remote mount transceivers (not 9800
series), this switch is used to turn transceiver power on
and off. A separate 9-16 VDC, 200 mA power supply
(such as PN. 563-0001-005) must then be plugged into
the RPI power jack to provide power to the RPI.

Cable Information

The cables from the RPI to the computer and
transceiver are not included with the RPI. The -9800-
RPI has afemale DB9 connector for the computer
connection. Since most computer serial ports have a
male DB9 or DB25 connector, amale DB9 to femae
DB9 or DB25 isusualy required. Thisis a standard
cable available at most computer supply stores. A suit-
ablecableisalso listed in Table 1-1.

The cable from the RPI to the transceiver has
modular telephone-style connectors on each end. It
plugs into the microphone jack on the front panel of
the transceiver. The cable for this application is also
listed in Table 1-1.

3.1.5 STARTING AND EXITING

To Start PCTrunk From Windows 3.1

In the Program Manager, open the PCTrunk group
window. Then double-click the PCTrunk icon.

To Start PCTrunk From Windows 95/98

Click the Start button and select the PCTrunk
group. Then double-click the PCTrunk icon.

To Exit PCTrunk:

Select File > Exit or pressALT + F4.

3.1.6 PROGRAMMING FILE TYPES

Programming datais stored in adisk file that can
be saved, read, copied, and deleted (see Section 3.3.1).
Thefilethat is stored for each programming session
has the .DAT extension.
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Figure 3-2 Main Screen (Later PCTrunk Versions)

3.1.7 HELP FILES

To display help information on the current screen,
click Help in the menu bar or press F1.

3.1.8 SCREEN GROUPS

General

The following screen groups are displayed:

Radio-Wide - These screens program parameters that
arethe samefor all systems and channels. Separate
screens are displayed for General, Conventional,
SMARTNET/SmartZone, and Mobile Options param-
eters. Refer to Section 3.4 for more information on
these screens.

System - These screens program the parameters that
are unique to the displayed Conventional,
SMARTNET, or SmartZone system. The system to be
edited is selected as described in Section 3.1.11.

Channel - This screen programs unique channel
parameters and assigns channels to each zone. The
specific parameters indicated in this screen are deter-
mined by the type of system selected in the “ Type”
box (Conventional, SMARTNET, SmartZone).

3.1.9 DISPLAYING SCREENS

The latest release of PCTrunk uses a different
method of displaying screens. Proceed as follows to
select which screens are displayed with the different
versions:

Revised PC Trunk (Version 5.10.0 or Later)

Revised versions of PCTrunk use a pane on the
left side of the screen (see Figure 3-2) to display the
screen structure similar to the directory structure of a
hard drive. Click the“+" to expand the branch and “—"
to collapseit. Then to display a screen, simply click its
name. The current screen may haveto be closed in
order to select another one.

Early PCTrunk (Versions Prior to 5.10.0)

With early versions of PCTrunk, the screens are
displayed in cascade style or they can be minimized
like any Windows screen. To cascade the active
screens, salect Window > Cascade from the menu bar.

To pop a screen to the front, click the applicable
button which follows. For example, if the Channel
screen is displayed and you want to quickly pop the
Radio-Wide screen to the front, click the Radio-Wide
button. These buttons can be displayed or hidden by

Revised January 2001
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clicking Window > Toolbar. A window can aso be
displayed by selecting it in the Window Menu.

d:é;d % File Size:

Radic wide Eystem Channzl | '] |

Screen Pop-Up Buttons
(Early PC Trunk Versions)

3.1.10 FILE SIZE INDICATOR

The maximum number of channelsthat can be
programmed may be limited by the available memory
space in the radio (see Section 1.5.3). A running indi-
cation of the amount of memory used by the current
data(if it was downloaded to the radio) is displayed by
abar graph as shown in Figure 3-2 and the preceding
illustration. When the bar reaches the right end, avail-
able memory is full and some channels may need to be
deleted to program more information.

3.1.11 CREATING AND DISPLAYING
SYSTEMS

To create anew SMARTNET or SmartZone
system, select Systems > Add Systems and then the
desired system type from the menu bar (see Section
3.3.5). Thismenu is also used to delete a system.

NOTE: Only one conventional system can be set up,
and it is automatically created when a new fileis
created as described in Section 3.3.1. Therefore, there
is no option to add a conventional system.

Only one system can be displayed at atime, so
select the system to be edited as described in the
preceding section. Systems are indicated by number
and type. Channels and talk groupsfor all programmed
systems are set up in the Channels screen. Therefore,
any channel can be selected when programming
channel information.

3.2 PROGRAMMING PROCEDURE

The following is ageneral procedure you can use
to program atransceiver.
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3.2.1 PRELIMINARY
1. Select aprogramming file asfollows:

Create a New File - To start with anew file
containing default parameters, select File > New
and then the frequency band of the radio (VHF/
UHF/800 MHz).

Open An Existing File - To open an exigting file
stored on disk, select File > Open and then thefile
to be opened.

Upload a File From a Radio - To transfer afile
from aradio to the computer to edit or useasa
basis to program another radio, connect theradio to
the computer as described in Section 3.1.4. Then
turn the radio on and select Upload from the menu
bar.

2. Before or after creating the programming file, be
surethe correct type (98xx mobile) isselected by the
Radio Type menu (see Section 3.3.2).

3. A conventiona systemisautomatically set up when
anew programming fileis created. If SMARTNET
or SmartZone systems are also to be programmed,
set them up as described in Section 3.1.11.

3.2.2 PROGRAMMING RADIO WIDE
PARAMETERS

1. Todisplay the Radio Wide screens, click the screen
name under Radio Widein the left pane or click the
Radio Wide button (see Section 3.1.9).

2. Program the applicableinformation in these screens
as described in Section 3.4.

3.2.3 PROGRAMMING CONVENTIONAL
CHANNELS

NOTE: If no conventional channels are programmed,
skip this section.

1. Make sure the conventional system is displayed by
clicking it in the left pane or selecting Window >
Conventional in the menu bar.
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2. If required, display the Conventional System
programming screens by clicking the System button
or selecting Window > Conventional System (see
Section 3.1.9).

3. Program the conventional systems and channels as
described in Section 3.5.

3.2.4 PROGRAMMING SMARTNET AND
SMARTZONE SYSTEMS

NOTE: If no SMARTNET or SmartZone systems are
programmed, skip this section.

1. Make sure the desired SMARTNET or SmartZone
systemisdisplayed by clicking it in the left pane or
selecting Window > SMARTNET or SmartZonein
the menu bar.

2. If required, display the screens for that system by
clicking the System button or selecting Window >
Desired System (see Section 3.1.9).

3. Program the SMARTNET/SmartZone system and
talk groups as described in Section 3.6.

4. To program additional SMARTNET/SmartZone
systems, add a new system as described in Section
3.1.11 and repeat Section 3.6.

3.2.5 PROGRAMMING RADIO
(DOWNLOADING FILE)

When al the required programming information
has been entered in the various programming screens,
the information can be programmed (downl oaded) into
the radio. When downloading afile, be sure that all
connections between the computer and radio are
secure, the radio is turned on, and the proper serial
port is selected (see Section 3.3.1).

Then select Download > Parameters to 98xx
Mobile. If no fileis currently loaded, a dialog box
appearsto select the desired file. If afileis aready
loaded when Download is selected, the current fileis
transferred to the radio.

NOTE: The information which follows (Sections 3.3-
3.6) provides detailed descriptions of the parameters
that are displayed in the various PCTrunk screens.

3.3 MENU COMMANDS

File Radio Series Download Swysterms Tools  Window Help

Fflun Dnvsahin Damd. OAM kLIS Ciln Coemat BB Citn Cinn- |

Menu Bar

3.3.1 FILE MENU

| File
Open... UHF (low) default
Close UHF (high) default
800 Mhz default

Save

Save As
Print...
Select Communications Port

: CAPCTRUNK\EFJOHNSN.DAT
: CAPCTRUNKN\UHFFREQ.DAT
: CAPCTRUNKWHFFREQ.DAT
: CAPCTRUNKYS00FREQ.DAT

[ (00 N =

Exit

New - Creates a programming file with default param-
eters for the selected frequency range.

Open - Opens a programming file that was previously
saved to disk. If amodified fileis currently open, you
are asked if that file should be saved before the new
fileis opened.

Close - Closes the current file. If the file has been
modified and the changes have not been saved, you are
asked if the changes should be saved before closing.

Save - Saves the current file to disk using the current
file name.

Save As- Same as*“ Save” except you are prompted to
enter anew file name if desired.

Print - Prints the information in the current file.

Select Communications Port - Displays the Commu-
nications Port dialog box which is used to select the
serial port that is used to connect the transceiver to the
computer (see Section 3.1.4).

Exit - Closes the PCTrunk program. If the current file
has been modified and the changes have not been
saved, you are asked if the changes should be saved
before closing.
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3.3.2 RADIO SERIES MENU

RBadio Series QM
50 Portable
53xx Mobile
7780 Portable
¥ 98xx Mobile
The Radio Series menu show above selects the
radio type (9883 Mobil€e) being programmed.

3.3.3 DOWNLOAD MENU

Systems Tool

Parameters to 98:x; Mobhile
DSP Code to 98¢ Mobile

Par ameter sto 98xx M obile - Transfers the current
programming file to the radio connected to the
computer.

DSP Code to 98xx M obile - This function along with
aspecial DSP upgrade file from E.F. Johnson are used
to upgrade the DSP firmware. To put the radio in
download mode, power the radio off, temporarily
connect the microphone, and power it back on while
pressing the microphone PTT switch. The DSP down-
load mode isthen indicated by “CODE” in the display.
The microphone is then disconnected, the RPI
connected, and the code downloaded.

3.3.4 UPLOAD MENU
The Upload Menu is displayed only in the

opening screen before a programming file is created.
The following options are displayed:

[S[LELE Help

Parameters from 98xx Mobile
Yersion Information from 98:xx Mobile

Parametersfrom 98xx Maobile - Transfers the
programming data from aradio to the PCTrunk
program. This data can then be viewed, edited, or
saved to adisk file as desired.

Version Information from 98xx Mobile - Displays
the software version number and serial number of the
connected radio.
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3.3.5 SYSTEMS MENU

Add System d SMARTNET

Delete Selected System SmartZone

The Systems Menu is used to create new
SMARTNET and SmartZone systems. It isalso used
to delete current systems. Conventional systems
cannot be added because only one can be created.
Refer to Section 3.1.11 for more information.

3.3.6 TOOLS MENU

The Tools > Convert File Format function is not
used with this transceiver. It converts Format 5.4 files
to the 5.5 format. All 98xx models use Format 5.5.
3.3.7 WINDOW MENU

¥indow

Cascade
¥ Tool Bar

¥ 1: Conventional
2: SMARTNET

1 Radio ¥ide Parameters
¥ 2 Channel Parameters

3 Conventional System

The Window Menuis used to select the system to
be edited. It can also be used to pop one of the screens
to the front. Refer to Section 3.1.9 for more
information.

3.3.8 HELP MENU

| Help
Contents
Search for Help On...

About PCTrunk...

Contents - Displays the help system table of contents.

Search For Help On - Displays the search dialog box
that allows searching for a help topic by keyword.

About PCTrunk - Displays the software version
number of PCTrunk and other information.
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3.4 RADIO-WIDE PARAMETER SCREENS
3.4.1 INTRODUCTION

The radio-wide screens program the parameters
that are the same for all systems, channels, and zones.
Separate screens are used for General, Conventional,
SMARTNET/SmartZone, and Mobile Options param-
eters. Refer to the information which follows.

3.4.2 RADIO-WIDE GENERAL SCREEN

Radio Wide Parameters
General | Conwventional | SMARTNET / SmanZone | Portable Options |

Band: 800 MHz

Zones Options

X Backlight Keypress
Total Zones 4 o g P

CurrentZone: [ 1 4| »
Zone Alias: MINNESOTA
® Power-Up on Home Zone

[~ Battery Saver
™ Keypad Lockout

Defaults Radio Wide Scan List... I
Home Zone: IW MINNESOTA LI Assign Function Buttons I

Backlight ON Tirne 3 il sec

Band

Displays the operating band selected by the Radio
Type Menu (see Section 3.3.2). The selected oper-
ating band must match that of the radio being
programmed.

Zones

Total Zones- Thetotal number of zones currently set
up. The maximum number allowed is 16. Zones are
added by clicking the Add button (see following).

Current Zone - Indicates the currently selected zone.
To select another zone, click the up/down arrows.

Zone Alias - Edits the unique alphaidentification
for the displayed zone. Up to 8 characters can be
entered. The zone aliasis briefly displayed when-
ever anew zoneis selected. Refer to Section 1.5.3
for more information on zones.

Add (Zones) Button - Adds another zone.

Delete (Zones) Button - Deletes the |ast zone added.

Defaults

Home Zone - Selectsthe zonethat is selected by the
Home Zone option switch if programmed.

Options

Power-Up On Home Zone - If checked, the home
zone is always selected at power-up.

Beeps- If checked, all tonesare enabled. Otherwise,
no tones sound (see Section 2.3.8).

NOTE: With PCTrunk, Version 5.10.0 or later, the
following screens are selected by clicking their name
in the left pane, not by clicking the button in the
General screen.

| Radio Wide Scan List.. |RadioWideScan List

NOTE: The radio-wide scan list cannot be pro-
grammed until all channelsto be included have been
set up as described in the Conventional and
SMARTNET/SmartZone sections (3.5 and 3.6,
respectively).

Clicking the Radio Wide Scan List namein the
left pane or that button in the General screen displays
the following screen which programs the radio-wide
scan list described in Section 2.3.11. The buttons and
other parametersin this screen are as follows:

Zone  Zone Alies Channel  Channel Type
1 [HNESOT 1 ANALOG (1)
2 1 MINNESOT 2 ANALOG (1)
3 1 MINMNESOT 3 ANALOG (1)
4 1 MINNESOT 5 SMMNET (2) Cancel
5 1 MINNESOT 4 SMINET (2)
B 1 MINMNESOT 7 SMZONE (3)
7 1 MINNESOT B SMZONE (3)
g

g
10 Delete Entry

Scan Hold Time: Wﬂ sBC
Radio-Wide Scan List Screen
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| MadifyList. | Button - Displays the following
screen that selects the channels in each Zone and
System that are in this scan list. Select each Zone
and then the channelsto beincluded from that zone.

Delete Entry - Deletes the selected channel from the
scan list.

Scan Hold Time - This programs the delay that
occurs before radio-wide scanning resumes after a
message is no longer being received. Times of

0 - 7.5 seconds can be programmed (see Section
2.3.11).

w Modifiy Radio Wide Scan List _ O] x|
Mumber of elements selected for scan list 7
Zone Channel
Type(system):
W 1. COMY 1 Analog (1)
W2 COMY 2 Analag (1)
W 3 COMY 3 Analag (1)

W 4 SMETNT 1

SMETNT 2

Srarthet (2)
Srarthet (2)
SmarZone (3
SmartZone (3)

C 4 COLORADD
C v 5:
: SMRTZMN 1
D SMRTZM 2

<]
o
]

D OO0 0000
L S o o B Y
=1

Close || Cancel |

Modify List Screen

‘ Agsign Function Buttans. . I A$ign Function Buttons

Clicking “Assign Functions Buttons” in the left
pane or that button in the General screen displaysthe
following screen which programs the five front panel
option switches. These switches can be programmed
with a different set of functions for each operating
mode (conventional and SMARTNET/SmartZone).
Refer to Section 2.3.4 for more information.

Program the option switches as follows:
1. Inthe System Type pull-down menu, select the

mode to be programmed (either conventional or
SMARTNET/SmartZone).
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Assign Function Buttons [ ]

System Type: ’W‘
Side Button 1 ’W
Side Button 2 W

Fikey [Beckign =

Fekey [scen o]

F3key [scamEat <

ey [fore cherge 3]

RGN Fenestar Tal

Assign Function Buttons Screen

2. To program a switch, click the arrow to display the
pull-down menu and then select the desired function
from that menu.

3. Repeat for all switches and modesto be
programmed and then exit this screen by clicking
the Close button.

3.4.3 RADIO-WIDE CONVENTIONAL SCREEN

Radio Wide Parameters

General Conventional ‘ SMARTMNET / SmartZone ‘ FPortable Options

DTHF AN ID:

12345678

The radio-wide conventiona screen is shown
above, and it is used to program the DTMF ANI ID.
This D is used on channels programmed for pre- or
post-transmit ANI (see Section 3.5.4) and consists of
eight digits from 0-9.

3.4.4 RADIO-WIDE SMARTNET/SMARTZONE
SCREEN

The radio-wide SMARTNET/SmartZone screen
is shown on the next page, and it is used to program
the following parameters:

Full Spectrum CC Scan

In a SmartZone system, if all potential control
channel frequencies have been searched, the radio
enters a channel-by-channel search across the full
spectrum that the radio covers. Thetimer sets the time
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Radio Wide Farameters

Generall Conventional  SMARTHET / SmartZone | Mobile Options

rFull Spectrum CC Scan | [ ¥oice On Control

® 0ff (@ Disable
CiOn Timer l?il 280 (" Enable .
Site Lock Time: I 15 EI B
[Hot DTMF Activation Time: I 500 il M3Ees
® Disable Pending Emergency
O Enatble Tirne: I 500 il miec

r Adjustable Parameters

Busy Over-ride Delay: I 0 il ZEC
affiate Hoort | 1 =] see
Failzoft Inactivity: ITEI IEC

r Display Dptions

® Talk Group on Rx
CPITID

rScan Talkback

) Selected Group
® Active Group

Radio Wide SMARTNET/SmartZone Screen

it performs this scan before it checks the expected
frequencies again. After it checks these frequencies, it
returns to full spectrum scanning. This cycle repeats
until acontrol channel is found.

On-Off - Enables or disables full spectrum scan.

Timer - Setsthe time that full spectrum scanning
occurs as just described.

Hot DTMF

Enable/Disable - When enabled, allows the user to
send DTMF tones while transmitting. When
disabled, pressing numeric keys (0-9, % , #) while
transmitting has no affect.

Display Options

These functions select what is displayed when
group calls are received (see Section 2.5.3). If neither
function is selected, the selected talk group diasis
aways displayed. Both cannot be selected.

Talk Group on Rx - The dias of the talk group on
which the call is being received is displayed.

PTT ID - The ID of the mobile placing the cal is
displayed. If the ID matches an ID in the Trunking
Cdl Ligt, thedias of that ID is displayed instead.

3-9

Scan Talkback

When a message is received when scanning, this
parameter selects how the radio responds during the
call hang time. “ Selected Group” forcesit to transmit
on the selected talk group, and “Active Group” forces
it to transmit on the scanned or active talk group.

Voice On Control

With SmartZone operation, some remote sites are
designated Voice On Control sites. In these sites, if all
available traffic channels are occupied, control chan-
nels become traffic channels when additional traffic
channels are requested. The Voice On Control parame-
ters determine how the radio reacts to various situa-
tions that may occur. For example, when a conversa-
tion is complete, the radio may look for a control
channel that has become a traffic channel.

Enable/Disable - Determinesif the voice on control
parameters are active.

Site Lock Time - Thisisthe amount of time aradio
remainson the VVoice On Control site beforelooking
for another site.

Activation Time - Thisisthe amount of time the
radio waits when the control channel comes back
from Voice On Control before it transmits any
pending ISWSs. This prevents al radios on a Voice
On Contral site from submitting ISWs at the same
time.

Pending Emergency Time - Thisis the amount of
time the radio waits to submit an Emergency |SW
after the control channel returns from the Voice On
Control mode.

Adjustable Parameters

Busy Override Delay - With SmartZone operation,
thisisthe amount of time auser must pressthe PTT
switch to override a SmartZone busy that occurs

because some member of thetalk groupis present at
asite where there are no traffic channels available.

Affiliate Hold Off - With SmartZone operation, this
isthe delay time that occurs after acquiring the
control channel before it sends an affiliation |SW.
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This prevents all radios on the system from sending
affiliation ISWs at the same time.

Failsoft I nactivity - Programsfail soft operation (see
Section 2.5.11). If the radio remains inactive (no
receive or transmit activity on channel) while oper-
ating in the fail soft mode for the programmed time,
the radio momentarily leaves the failsoft mode and
attempts to find a control channel. If “0” is
programmed, the radio does not |eave the fail soft
mode.

3.4.5 RADIO-WIDE MOBILE OPTIONS SCREEN

Radio Wide Parameters

General | Conventional | SMARTHET / SmanZone  Mohile Options |

rHangup Box Monitor

® Off
C On

Backlight Level

® Ciff
O Medium
O High

rIgnition Power Down Time |

ITil min

® Timed
O Infinite

MinimumVqume:I 0 il

The radio-wide Mobile Options screen is used to
program the following parameters:

Backlight Level - Selectsthe default backlight level
whenever power ison. This setting can be over-
ridden by the backlight option switchif it is
programmed.

Hang-Up Box Monitor - Selecting “ Off” disables
microphone off-hook detection. Taking the micro-
phone off-hook then does not disable coded squelch
functions or scanning. Selecting “On” enables
microphone off-hook detection.

Ignition Power Down Time - When the ignition
switch controlstransceiver power, this setsthe delay
that occurs between when the ignition switch is
turned off and when transceiver power actually
turns off. Times of 0-254 minutes can be
programmed or an infinite time (no turn-off) can be
selected (Section 2.3.9).
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Minimum Volume - Setsthe minimum volumelevel
that can be selected by the volume control. This can
be used to prevent missed messages caused by inad-
vertently turning the volume down too far. Relative
levels of 0-255 can be set (“0” setsthe lowest
minimum volume).

3.5 PROGRAMMING CONVENTIONAL
SYSTEMS AND CHANNELS

3.5.1 INTRODUCTION

The following information describes how
conventional channels are programmed. Conventional
systems do not need to be set up because only one can
be programmed, and it is automatically set up when
the programming file is selected as described in
Section 3.1.6. Up to 256 conventional channels can be
programmed (if no SMARTNET/SmartZone systems
are programmed). Refer to Section 1.5.3 for more
information on systems and channels.

The following is the recommended procedure for
programming conventional channels:
1. Program theradio-wideinformation as described in
Section 3.4.

If other types of systems are programmed, make
sure the conventional system is selected in the left
pane or by selecting Window > Conventional in the
menu bar (see Section 3.1.9).

Program the conventional system information and
then the channel information as follows.

3.5.2 CONVENTIONAL SYSTEM GENERAL
SCREEN

The conventional system General screenisshown
on the next page, and it programs the following
parameters:

Timers

Tx Time-Out Timer - Thistimer limits the length of
transmissions (Section 2.3.7). Timesup to 3
minutes, 45 seconds in 15-second steps can be
programmed.
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Penalty Timer - This timer disables transmitting Scan List Button

after the time-out timer expires (Section 2.4.7).

Times up to 3 minutes, 45 seconds in 15-second Clicking Scan List in the left pane or that button

steps can be programmed. in the General screen displays the preceding screen
which is used to program the conventional scan lists

Conversation Timer - Thistimer limits the tota described in Section 2.4.11.

length of aconversation (Section 2.4.8). Timesupto

7.5 minutesin 0.5-minute steps can be programmed. NOTE: The conventional scan lists cannot be
programmed until all the conventional channels are

programmed. Therefore, first program the channels as

described in Sections 3.5.3 and 3.5.4.

System Index: 1 System Type: Conventional

General | To modify alist, click and the

screen which follows is displayed. Select the desired
scan list in the box on the top and then select the zone

Timers .
. and the channels from that zone to be included. Repesat
TxTime-OutTimer: | 45 & . .
X Time Gt imer 8 cec for each zone. Do this for each list programmed. The
Penalty Timer. [ 30 §fsec Delste Entlz) | button deletes the selected channel (s)
Conversation Timer. | 1.5 ﬂ friin from the scan list.
[ Keypad Selectakle CTCSS / DCS
[ Bugy Channel Overtide Scan List tn Madify: rﬂ
Conventional System General Screen Zone Channel
Channel Type:
@1 MINNESOTA -
O 2. NEBRASKA W 2: CORY 2 Analog
. . O3 1DhA, ™3 COMY 3 Analog
Busy Channel Override - Selects if the busy channel O 4 COLORADO r
. . . r
lockout feature can be overridden by quickly releasing = =
and then pressing the PTT switch (see Section 2.4.5). c oo comd anaos
C W 9 CORY 5 Analog
C W 10: CORY B Analog
O W11 CORNY 7 Analog
O W12 CORY 8 Analog
O r
c r
O r
Priatly Scan List1 Scan List 2 Scan List 3 o ml
Channgl |CONY 1 [¢None> [¢None>
CONY 5 COMY 3 Priority Channel
CONY 6 CONY 4 . Zone 1- MINNESOTA
o Coenct 1 CONV1
CHAN 2
| Clage: | | Cancel |
Conventional System Modify Scan List Screen
Highlighted Channel The following parameters are programmed in the
oz Hame. CONVE Conventional System Scan List Screen shown on the
|l eft.
Per-List Parameters Scan
Keypad Editing | Scan Mode: Scan Hold Time: Wﬂ s8C il
® Mo Priotity/Tx Selected | Lookback Time & Wﬂ . K eypad Editi ng
@itz Lookback Time B: ’Tﬂ sec
This function selects if the user is allowed to edit
Conventional System Scan List Screen the scan list. This requires the Scan Edit option switch
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as described in Section 2.3.11. User editing can be
enabled and disabled on each scan list.

Scan Mode

Sets the channel on which transmissions occur
when the PTT switch is pressed while scanning. A
different mode can be programmed for each scan list.
In addition, it selects if priority sampling is used and
also the type of priority channel (see the “Priority
Channd” description which follows). The following
modes are available:

No Priority - Priority sampling does not occur (all
channels are scanned in sequence). The radio trans-
mits on the selected channel.

Priority/Tx Priority - Priority sampling occurs
and the priority channel is the one programmed in
the selected scan list. The radio transmits on the
priority channel.

Priority/Tx Selected - Priority sampling occurs
and the priority channel is the one programmed in
the selected scan list. The radio transmits on the
selected channel.

Priority on Sel Chan - The priority channel is
aways the selected channel (even if the scan list is
programmed with a priority channel). Theradio
transmits on the selected channel.

Talkback Scan - No priority sampling occurs
(even if the scan list is programmed with a priority
channel). The radio transmits on the channel of a
call while scanning is halted. Then when scanning
resumes, it transmits on the selected channel.

Scan Timers

Scan Hold Time - Setsthe delay that occurs before
scanning resumes after asignal is no longer
received (see Section 2.3.11).

L ookback Time A - Thistime determines how
often the priority channel is checked for activity.
Times of 0.25-4.00 secondsin 0.25-second steps
can be programmed.

L ookback Time B - Thistime determines how
often the priority channel is checked once an incor-
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rect Call Guard (CTCSS/DCS) code is detected.
Since it takes much longer to detect an incorrect
Call Guard signal than a carrier, thistime should be
relatively long to prevent the interruptions from
making a message difficult to understand. Times of
0.5-8.0 seconds can be programmed in 0.5-second

steps.
Priority Channel Selection

The Scan Mode parameter in the preceding
Conventional System Scan List screen selectsiif
priority channel sampling is enabled on the selected
scan list. It also selects the type of priority channel
(either fixed or the selected) if applicable.

If the“Priority/Tx Priority” or “Priority/Selected”
mode is programmed, fixed priority channel sampling
is selected. The fixed priority channel must then be
chosen for the scan list. To do this, click the
[ SetPiisiity__| button in the preceding Modify Scan List
screen and then select the desired zone/channel. Refer
to Section 2.4.12 for more information on priority
channel sampling.

3.5.3 SETTING UP CONVENTIONAL
CHANNELS

The conventional Channel screen shown in
Figure 3-3 which follows is displayed when a conven-
tional channel is selected. This screen programs
unique channel parameters and also assigns channels
to the selectable zones displayed by the transceiver.

The general procedure for setting up a conven-
tional channel is as follows. Refer to the descriptions
which follow this procedure for information on the
parametersin the channel screens.

Make sure that the desired zone is selected in the
Zone box.

1.

Select the channel number in the Channels Index
box which isto be programmed with the channel. If
the channel number display mode is selected (see
Section 2.4.2), this will be the number displayed
when the channel is selected.

To assign a conventional channel, select “ Conven-
tional” asthe channel type.
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Channel Parameters —
Selected Channel Transmit Power TX Time-0ut
Zone: |1: MINNESOTA 4 O Law @ off
C High C On
Channels @ Switch
Inclex:
2: CONW 2
3 COMY 3 Busy Channel Lock-Out Chan. Modulation
4 SMRTNT 1 Wi
5 SMRTNT 2 | O Off ® Noise S
O Tane 0 Marrow
Coded Squelch " "
el Bl w. Modify Channel List
Ch 1T
annel fype C MNone one
|1: Conventional ﬂ ® CTCSS ® CTCS = : :
— — [ EE
Alias: EIE ==
System Specific Information Signaling Transmit: 851.0125 hHz
® Off e
Transmit Beceive: : Beceive: 851.0125 Lz
BE1.012EMhz 8510125 Mhz O Leading ANl B¢ DTMF enabled
O Trailing AN
P Enahle this channel
[ R Only
™ Caopy parameters fram channel: ﬂ

Figure 3-3 Conventional Channel Screen

4. Click the Modify button to display the screen which
enables that channel and programs the alias (tag)
and transmit and receive frequencies. Then program
the other parameters in the main part of the screen.
Refer to the next section for more information.

3.5.4 CONVENTIONAL CHANNEL SCREEN
PARAMETERS

The following parameters are programmed in the
conventional channel screen shown in Figure 3-3.

Selected Channd

Zone Box - Clicking the arrow to the right of this
box displaysthe available zones. Click on azoneto
select it. Zones and zone aliases are set up on the
Radio-Wide General screen described in Section
34.2.

Channel Index Box - Displaysthe available chan-
nelsin the selected zone. The channel typeis
selected by the Channel Type box below it.

todify... I Modify Button - Displays the small
screen shown in Figure 3-3 which enables the

3-13

channel (makesit selectable) and programstheaias
(tag) and transmit and receive frequencies.

The parametersin this screen are as follows:

Channel - Selects the channel to be edited.

Alias - Programs the identification that is displayed
when the channel is selected. Upto 8
characters can be programmed.

Transmit - Programs the transmit frequency of the
channel.

Receive - Programs the receive frequency of the
channel.

Enable This Channel - The box must be checked for
the channel to be selectable.

Rx Only - The box is checked if the channel is
receive-only (transmitter disabled).

Copy Parameters From Channel - If another channel
is selected, the parameters from that
channel are copied to the new channel.

NOTE: Channel numbers not assigned must be
programmed for conventional operation and then not
enabled in the Modify screen because SMARTNET/
SmartZone channels cannot be disabled.
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Channél Type

Channel Type Box - Selects the specific system
fromwhich the channel isselected. All programmed
systems are displayed by number and type (conven-
tional, SMARTNET, SmartZone). When adifferent
channel typeis selected, the screen for that type of
channel is automatically displayed.

System Specific Information - With conventional
systems, indicates the frequency of the selected
channel without having to select the Modify box.

Transmit Power

Thisfixes the transmit power on the channel for
the high or low level or allows it to be switch select-
able (the Hi/Lo Power option switch is then required).
Refer to Section 2.4.10 for more information.

Tx Time-Out

This enables or disables the time-out timer on the
channel. The time-out timer timeis programmed in the
conventional system General screen (Section 3.5.2).

Busy Channée L ockout

Off = disabled, Noise = transmit disallowed if
carrier is detected, Tone = transmit allowed with
carrier detected only if correct Call Guard (CTCSY
DCS) code is detected.

Coded Squelch

This sets the transmit and receive Call Guard
(CTCSS/DCS) coding, if any, used on the channdl. I
“None” is selected, no code is transmitted and carrier-
controlled squelch is used when receiving (Section
2.4.6). The standard Call Guard tones and codes are
listed in Table 3-1 on page 3-23.

Signaling
Off - No ANI signaling is used.
Leading ANI - A DTMF-coded ID is sent at the

beginning of each transmission. ThisID issetinthe
radio-wide conventional screen (Section 3.4.3).
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Trailing ANI - A DTMF-coded ID is sent at the end
of each transmission.

Channel Modulation

This selects if the channel modulation is wide-
band (5 kHz) or narrowband (2.5 kHz).

3.6 PROGRAMMING SMARTNET/SMARTZONE
SYSTEMS AND CHANNELS

3.6.1 INTRODUCTION

To program SMARTNET and SmartZone
systems and channels, proceed as follows:

1. Program the SMARTNET/SmartZone radio-wide
information as described in Section 3.4.

2. To create anew SMARTNET/SmartZone system,
select the Systems > Add Systems in the menu bar
(see Section 3.1.11). Up to sixteen systems of any
type can be programmed as described in Section
1.5.3.

3. Program the SMARTNET/SmartZone system infor-
mation as described starting in the next section.
Make sure the desired SMARTNET or SmartZone
system isdisplayed by clicking it in the left pane or
selecting it in the Window menu in the menu bar
(see Section 3.1.9). Then program the channels as
described starting in Section 3.6.8.

3.6.2 SMARTNET/SMARTZONE SYSTEM
GENERAL SCREEN

The SMARTNET/SmartZone System General
screen is shown on the next page, and it programs the
following parameters:

Restricted Access

Change System ID - Clicking Change System ID in
the left pane or that button in the General screen
displaysthe Change System ID screen whichisused
to enter the system ID of the system. ThisID is
entered as a hexadecimal number from 0-9 and A-F.
Valid numbers are from 0001-FFFF. The system ID
corresponding tothedesired | D must also belocated
in the “key” subdirectory of the program file.
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System ID - Read-only field which showsthe ID of
the system currently being edited.

SMARTHET [ Smartone Systemn

System Index: 2 System Type: SHMARTHET

r Restricted Access

System [D: 2 [hex] ) _
r Dynamic Regrouping

[ Enable faor this system

Zone: |1: ZO0ME 1 vl
Channel: |<N0ne> 'I

r Affiliation Type
® Automatic O ORPTT

r Splinter Channels

(@ Dizabled () Enabled

r Channel Modulation

® ‘wideband

rPTT ID
(® Dizabled () Enabled

Time-DutTimer:I 0 ilsec

r Trangmiggion Trunking 154 Delay: 4 I | » |
@ Dizabled (O Enabled less I 0 mare

SMARTNET/SmartZone System General
Screen

Splinter Channels

When splinter channels are enabled, the receive
and transmit frequencies are 12.5 kHz lower than the
normal frequencies. Splinter channels are used only as
required in the Mexico and Canada border areas for
frequencies between 806 and 820.975 MHz.

Channel Modulation

When “Wideband” is enabled, the radio operates
with a4 kHz maximum deviation between 821.000
and 824.975 MHz and 5 kHz maximum deviation for
all other frequencies. When it is disabled, deviation is
5 kHz with all frequencies.

PTTID

This enables or disablesthe PTT ID.
Transmission Trunking

Selecting “ Disabled” removes the hang time at
the end of anormal conversation. Thisforcestheradio
to always contact the control channel when seeking a

channel grant instead of being able to key up on the
hang time of another conversation.

System Lists

Clicking System Listsin the |eft pane or that
button in the General screen displays the screens used
to program the various lists that are unique for each
SMARTNET/SmartZone system. Refer to Section
3.6.7 for more information on these lists.

Dynamic Regrouping

Enable For This System - When thisbox is checked,
adynamic regrouping channel is enabled. Thisisa
SMARTNET channel which has the corresponding
talk group dynamically set by the dispatcher.

Zone - The physical zone containing the dynamic
regrouping channel. The value is selected on the
Channel Parameters screen.

Channel - The physical channel used for dynamic
regrouping. The value is selected on the Channel
Parameters screen.

Affiliation Type

Automatic - The radio immediately affiliates with

the central controller as soon asit isturned on and
automatically re-affiliates each time the talk group
is changed.

On PTT - Theradio affiliates with the central
controller only when the PTT switch is pressed.

Time-Out Timer

This programs the time-out timer setting for the
system. It can be programmed for O min, 15 sec up to
3 min, 45 sec or it can be disabled (see Section 2.3.7).

ISW Delay Time
Increasing or decreasing this value changes the

transmission timing of ISWs relative to the reception
of OSWs.

3.6.3 SMARTNET/SMARTZONE SYSTEM
OTHER ID’S SCREEN

The SMARTNET/SmartZone Other 1D’s screen
follows, and it programs the these parameters.
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System Index: 4 System Type: SMARTMET

General | Phone Interconnect | Talk Groups | Emergency Seftings

Imdividual 1D |1
Connect Tone: I'IDE.SS . Hz

SMARTNET/SmartZone Other IDs Screen

Individual ID - Uniquely identifiesthe radio on a
particular system. Each radio must have a different
Unit ID. Valid Unit IDs are from 1-65535.

Connect Tone - The tone expected by the controller
on the traffic channel to verify that a subscriber
transmission is occurring. This tone should be set
the same asit isin the controller.

3.6.4 SMARTNET/SMARTZONE SYSTEM
PHONE INTERCONNECT SCREEN

Announcement Groups

Message Aliasing T
Trunking Phone List T

o

[ 1

i

Control Channels
Trunking Call List

Priarity Manitor Scan
Status Aliasing |

Phaone Number
8356222

Name:
ED JOHNSON

=l |

=

Modify Trunking Phone List

1
2
3
4
5
B
7
8

Entiy Data

Entry Number E';
ED JOHMSON
Phane Number: [a35.5200

|
10
1
12
13
14
15
16

Entry dliaz:

The SMARTNET/SmartZone Phone Intercon-
nect screen is shown above, and the parameters it
programs are as follows:

Phone I nterconnect

Refer to Section 2.5.6 for more information on
telephone calls.

Disabled - Telephone calls cannot be placed or
received.

Answer Only - Telephone calls can be received but
not placed.

Revised January 2001
Part No. 001-7780-501

3-16

List Only - Telephone calls can be placed and
received, and numberscan berecalled from memory
only.

Unlimited - Telephone calls can be placed and
received, and numberscan berecalled from memory
or dialed using a microphone keypad.

Private Call

This is the same as the preceding Phone Intercon-
nect except it isfor private (unit-to-unit) calls. Refer to
Sections 2.5.4 and 2.5.5 for more information.

Private Call |1

This programs either standard (Private Conversa-
tion 1) or enhanced (Enhanced Private Conversa-
tion™") private calls asfollows:

Standard - The user does not receive any feedback
when the called radio is not active in the system.
Only a“No Answer” isreceived if the called radio
does not answer.

Enhanced - When acall is placed, the system tells
the user if the called radio is currently activein the
system and within range. The calling radio displays
“NO ACK?” if the called radio is not activein the
system and “NO ANSWR” if it is active but does
not answer.

Phone DTMF Timing

Initial Delay - Delay from 50-500 millisecondsfrom
when atraffic channel is granted for phoneintercon-
nect to the start of the dialing out of the phone
number.

Digit Duration - Duration from 50-500 milliseconds
of each phone number digit.

Inter-Digit Delay - Delay from 50-500 milliseconds
between each digit of a phone number.

3.6.5 SMARTNET/SMARTZONE SYSTEM

TALK GROUPS SCREEN

The SMARTNET/SmartZone Talk Groups screen
is used to set up SMARTNET/SmartZone talk groups
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SMARTHET [ SmartZone System

System Index: 2 System Type: SMARTMET

| Emergency Settings |

[ &ddTG.. | [ DeleteTG |

Talk Group: |1 vl

FailSoft Channel

® Disabled
(1 Enakbled

Tw Frequency: l— MHz
R Frequency: I MHz

SMARTNET/SmartZone System Talk Groups
Screen

and program unique talk group information. This
screen is shown on the next page, and the parametersit
programs are as follows:

Talk Group - Selectsthetak group to program. This
isthe actual 1D of thetalk group. Talk groups are
added or deleted by clicking the Add TG or Delete
TG button (seefollowing). Talk groups are assigned
to channels on the channel screen (see Section
3.6.9).

- Clicking this button displays adialog

box that adds a new talk group. The alias (al phatag)
of up to 8 charactersis entered, and the new group
isthen added after the othersthat are already set up.
Each SMARTNET/SmartZone system can be
programmed with up to 256 talk groups.

Delet= TG | - Clicking this button deletes the
currently selected talk group (the one displayed in
the “Talk Group” box).

Failsoft Channel

Enable - Enables afail soft channel onthetalk group
if acontroller failure occurs (see Section 2.5.11).

Disable - The failsoft mode is not entered if the
controller fails.

Tx/Rx Frequency - Programs the failsoft channel
frequency if “Enabled” is checked.

3.6.6 SMARTNET/SMARTZONE SYSTEM
EMERGENCY SETTINGS SCREEN

The SMARTNET/SmartZone Emergency
Settings screen and the parameters it programs are as
follows:

SMARTHET / SmartZone Systern

System Index: 2 System Type: SMARTHET

Generall DtherID'sl Phone Interconnect | Talk Groups :

r Emergency Call r Emergency Alarm

@ Disabled @ Dizabled
() Enabled O Narmal
) Silert

r Emergency HotMic

(@ Dizabled
1 Enabled

Tx Period: I 10 fl 360

Retry Counter

@ Limited: I'I ilattempts

1 Urilinnited

Emergency Call

Enable - When the Emergency option switch and
then the PTT switch are pressed, an emergency
group call istransmitted.

Disable - An emergency group call isnot
authorized.

Emergency Hot Mic

Enable - When an emergency alarm is generated and
the emergency alarm acknowledgment received, the
emergency mode is automatically entered and trans-
mitting beginsfor thetime specified by the Tx Period
parameter (see following).

Disable - Automatic transmissions do not occur.

Tx Period - Defines the period during which trans-
missions occur with the microphone audio unmuted
(without user intervention). Timesof 10-120 seconds
in 10-second steps can be selected.

Emergency Alarm

Disabled - No emergency signal is sent when the
user presses the Emergency option switch.

Revised January 2001
Part No. 001-7780-501



PROGRAMMING

Normal - When the user presses the Emergency
option switch, an emergency signal is sent to the
dispatcher. Audio and visual feedback is provided
by the radio.

Silent - Sameas“Normal” except no audio or visual
feedback is provided.

Retry Counter - When “Unlimited” is selected, an
emergency call is repeated until acknowledged or
canceled. When “Limited” is checked, cals are
attempted only the specified number of times.

3.6.7 SMARTNET/SMARTZONE SYSTEMLISTS
SCREENS

___Clicking System Listsin the |eft pane or the
button in the SMARTNET General screen
(if applicable) displaysthe screens used to program the
various lists that are unique for each SMARTNET/
SmartZone system. These screens are as follows:

Trunking Phone List Screen

Announcement Groups
[ Meszage Aliasing T
Trunking Phone List |

System ¢

1
1

Control Channels
Trunking Call List

Priarity Monitor Scan
Statuz Aliasing

Entry Alias - Up to 8 characters can be entered to
identify the phone number. Thisidentificationis
displayed when phone numbers are selected by the
user from the list. Only uppercase letters can be
entered, so lowercase letters are automatically
converted to uppercase by the program.

Phone Number - Thisisthe number dialed when the
location is selected. Characters that can be entered
include 0-9, #, (,), and P (a“P” programs a pause).
The maximum number of digits excluding (,) and
gpacesis 16, and the maximum including (,) and
spacesis 24.

Close - Clicking this button verifies the current
entry, storesit, and then closes the dial og box. If the
current entry contains an invalid field, the dialog
box does not close and the invalid field is high-
lighted.

Help - Accesses the Help screen. Help can also be
selected at any time by pressing the F1 key.

Message Aliasing Screen

Phone Humber
8356222

Name
ED JOHNSOMN

Modify Trunking Phone List

Entry Data

Eny Mumber, M
ED JOHNSON
BhoneNumber [isezzz |

Entry lias:

This screen programs the phone number list if
used (see Section 2.5.6). To edit thislist, click the
Trunking Phone List tab and then the “Modify List”
button on the right side of the screen. The following
information is then programmed in the dialog box that
isdisplayed:

Entry Number - This box selects the entry to be

edited. The scroll barsto theright of this box select
the desired entry. A phone list can contain up to 16
entries. Selecting anew entry number automatically
validates and stores the current entry. If the current
entry contains an invalid field (for example, too

many digitsin the phone number), the entry number

does not change and the invalid field is highlighted.
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Trunking Phone List Trunking Call List Status Aliasing System !
Llose Announcemern | Groups
Message Aliasing |, Contiol Channels 1 Friority Moritor Scan
I oy List,
ias- Close
Delete Entry Alias:

1{TO LUNCH

2|0FF DUTY Modify List
3

4

5 Dislete Eriy
[

7 Modify Message Alias

8 Help

9
101
11
12
13 Message Nurber [+l
14 pu

Close

Message Alias:

OFF DUITY]

This screen associates an alias (name) with each
message number (see Section 2.5.8). To edit thislist,
click the Message Aliasing tab and then the “Modify
List” button on the right side. The following informa-
tion isthen programmed in the dialog box that is

displayed:

M essage Number - This box selects the message to
be edited. The scroll bars to the right of this box
select the desired message number.

Message Alias - Programs the alias which can be up
to any 8 aphanumeric characters.
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Close Button - Validates the entry and closes the
dialog box. Theentry isalso validated when another
message number is selected.

Announcement Groups Screen

Per-System Lists

To edit an announcement group, click the
“Modify List” button on the right and the preceding
screen is displayed. Select the announcement group to
be edited from a pull-down menu selecting by clicking
the “AG” arrow. Then click the talk groupsto select/
de-select them and then click the “Update List” button
to make the changes.

[ Message Aliasing I Cantrol Channels 1 Priarity Monitor Scan System 2
Trunking Phone List Trunking Call List Status Aliasing
Amouncement Groups Control Channels Screen
P L
Close
Modify List
b T Seaen | Trunking Phane List T Trunking Call List I Status Alissing System 2
3249 Delets Entry Announcement Groups |
g 250 Message Aliasing Control Channels I Priarity Monitar Scan
8 TG: ol
; 245 |:
g 246 Close
9
10 g:g Index Txirequency Rofraquency [EE—
n 1 Madify List
12 2 | EeEe ]
13 3
}g 4 Delete Entry
18 . Modify Control Channel List X
Note:  SelectTGs o include in AG by "clicking” on TG - Help
"Click!" a secand fime to exclude TG, L
Control Frequency Entry
—
Control Channel T 4
This screen programs the announcement groups TransrtFruency | TR e
that are used to communicate with several talk groups Mate: Fxwil e set 45 MHz grestarhan T

simultaneously. There can be up to 3 announcement
groups per system, and each announcement group can
have up to 15 talk groups.

To create an announcement group, click the“Add
AG” button and the “Add TGsto the AG” screen
shown above is displayed. Enter the announcement
group 1D, click thetalk groups to sel ect/de-sel ect those
that are to be included, and then create the announce-
ment group by clicking the “ Create AG” button. To
delete the current announcement group, click the
“Delete AG” button.

AG: ' MNurnber of TGs: 4
. Update List .
TG:

Mote:  Select TGs to include in AG by "clicking" on TG,
"Click" a second time to exclude TG.

This screen allows the system manager to view
and edit the control channels. Each SMARTNET
system can have up to four control channels, and each
SmartZone system can have up to 32 control channels.
Only one control channel is active at atime.

To edit thislist, click the Control Channels tab
and then the “Modify List” button on the right side.
The following information is then programmed in the
dialog box that is displayed:

Control Channel - Selects the control channel to be
edited. To add anew channel, click the“New Entry”
button.

Freguency - The transmit and receive frequency of
the control channel. These are the mobile frequen-
cies, not the repeater frequencies. Only multiples of
5 kHz and 6.25 kHz are valid. With 800 MHz
frequencies, areceive frequency 45 MHz above the
transmit frequency is automatically entered.

New Entry Button - Click this button to display the
dialog box used to add another control channel.
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Trunking Call List Screen

n Lists

iouncement Groups System 2
155808 Aliasing T Caontral Channels T Priotity Monitor Scan e
ding Phone List Trunking Call List | Status Aliasing
ID

1 123

2 Modify List I

3

] P—— .

5 W Madify Trunking Call List X Toa Ey

B

7 Entry Data Toss o

8 [ geee ] &P

B Enfry Murnb
; s [l

E EnryAliss:  [FREDW

13

CalllD

14 L 123

15

16

This screen allows thelist of IDs used for private
callsto be programmed. A maximum of 16 I1Ds can be
programmed (see Sections 2.5.4 and 2.5.5).

To edit thislist, click the Trunking Call List tab
and then the “Modify List” button on the right side.
Thisfollowing information is then programmed in the
dialog box that is displayed:

Entry Number - This box selects the entry to be
edited. The scroll barsto theright of this box select
thedesired entry. A privatecall list can contain up to
16 entries. Selecting a new entry number automati-
cally validates and stores the current entry. If the
current entry contains an invalid field, the entry
number does not change and the invalid field is
highlighted.

Entry Alias - Up to 8 characters can be entered to
identify the user being called. Thisidentificationis
displayed when the mobile to be called is selected
by the user from the list. Only uppercase letters can
be entered, so lowercase letters are automatically
converted to uppercase by the program.

Cdl ID - Thisisthe ID of the radio being called.
Valid entries are 1-65535. A “0” is detected as no
entry.

Close Button - Verifiesthe current entry, storesit,
and then closes the dialog box. If the current entry
contains an invalid field, the dialog box does not
close and the invalid field is highlighted.
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Priority Monitor Scan Screen

bystem Lists
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Trunking Phane List Trunking Call List Status Aliasing System 2
Annauncement Groups b
hMessage Aliasing Cantrol Channels T Priority Monitor Scan M
Scan List1 Scan List Scan List3 E
Pri. | SMRTNT 1 Pri. | <Nane> Pri. | CHAN 7

2 |SMRTNT 2 2 |CHANT 2 |CHANT

3|CHAN TS 3[CHAN 2 3[CHAN 2

4|CHAN 1B 4|CHAN 4 4|CHAN 3 Delete Entry

5 5 |CHAN 7 5

& & &

7 7 7 Help

] ] = —_—

3 E] w. Modify Priority Monitor Scan List [_ o] x

10 10
11 11
13 13 Scan List to Modify: IT_iI
1? 1? Number of elements selected for scan list: 6
18 16 Zone Channel
= Channel Type
1 MINNESOTA M 1: CHAM 1 Smaniet Sys 2
0 2 NEBRASKA ¥ 2: CHAM 2 SmanNet Sys 2
@3 10WA | ¥ 3 CHAN 3 Smarhet Sys 2
O 4 COLORADO ™4 CHAMA SmarNet Sys 2
OF& Zoneh [ 5 CHANG Smarthet Sys 2
Q& Zonef ¥ 6: CHANG Srnanthet: Sys 2
O7 Zone? ¥ 7. CHANT Srnanthet: Sys 2
OF& Zone I 67 (DIZABLED)  Analag
O & Zoned I= 87 (MISABLED]  Analog
O 10: Zone 10 Fi0: (DIEABLED)  Analag
O11: Zone 11 =11 (DISABLED)  Analog
012 Zone 12 F iz ([DISABLED)  Analog
O 13 Zone 13 =13 (DISABLED)  Analog
O14: Zone 14 =14 (DISABLED)  Analog
O 15 Zone 15 75 (DIZABLED)  Analag
O 16: Zone 16 I=16; (DIZABLED)  Analog
Priority Channel
Zone
Chamnel

Close

[ Hep |

Cancel |

This screen programs up to three Priority Monitor
scan lists that are allowed. Each scan list can contain
up to 15 channels plus a priority channel (see Section
2.5.12). These channels must be from the same
SMARTNET/SmartZone system. Channels set up for
other systems are not allowed.

To edit aligt, click the Priority Monitor Scan tab
and then click the “Modify List” button on the right
side. A screen similar to the bottom screen shown
aboveisthen displayed to select the channels to be
included in that scan list. Select channels as follows:

Select the scan list to be edited by clicking the scroll
bars next to the “Scan List To Modify” box.

Select the first zone with channels to be included
and select the desired channels. Repeat for the other
ZONes.

To select the priority channel, click the Set Priority
button. Then select the desired Zone/Channel or
“None” if no priority channd isto be scanned.
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Channel Parameters _ =]
rSelected Channel
Zone: |3: 104, LI Talk Group: | 245 < rTalk Permit Tone —
- | O Disabled
annels
Announcement Group: | 12 i oo
Index:
1: SMNET a _ [ System Scan
2 SMNET 2 ﬂ Emergency Group: || =] Scan List—————
3 SMMET 3 :
4 SMMET 4 O Nq S.can. List
@ Friority List 1
] ] O Friority List 2
|_Modity. | O Prinrity List 3
"Channel Type \ [ Auto Scan
Disahled
|2: Smarthlet LI \ gE:aEI':LJIeed
wm Modify Channel List X
System Specific Infarmation
System Type:  Systemn [D:
ShMARTHET 7811
Transmit: I Trunked
RBecaive: I Trunked
[ Enakle this channel
[ Fox Only
[ Copy parameters from channel: | 1 %'

Figure 3-4 SMARTNET/SmartZone Channel Screen

4. Repeat the preceding stepsfor the other scan listsif
applicable.

SatusAliasing Screen

Announcement Groups System ¢
[ Message Aliasing 1 Contral Channels 1 Priciity Monitor Scan
Trunking Phone List T Trunking Call List T Status Aliasing
Close
Alias:
1 |OFF DUTY Modify List..
2
3
4 Delete Enty
=]
g Modify Status Alias
g
Status Number
Status Alias: OFF DUTY]

3-21

This screen is shown above, and it programs the
alias for each of up to eight status conditions that can
be sent. The meaning of each status number is defined

by the system manager. Refer to Section 2.5.9 for
more information.

To edit thislist, click the Status Aliasing tab and
then the “Modify List” button on the right side. The
following information is then programmed in the
dialog box that is displayed:

Status Number - The scroll barsto the right of this
box select the status number that is to be edited.

Status Alias - Programs up to 8 charactersthat iden-
tify the status. Thisidentification is displayed when
the user selects a status condition.
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3.6.8 SETTING UP SMARTNET/SMARTZONE
CHANNELS

The SMARTNET/SmartZone Channel screen
shown in Figure 3-4 is displayed when the
SMARTNET or SmartZone channel type is selected.
This screen programs unique channel parameters and
also assigns channel s to the sel ectable zones displayed
by the transceiver.

The general procedure for setting up a
SMARTNET/SmartZone channel is as follows. Refer
to the descriptions which follow this procedure for
information on SMARTNET/SmartZone Channel
screen parameters.

1. Make surethat the desired zone is selected in the
Zone box.

2. Sdect the channel number in the Channels Index
box which is to be programmed with the channel.

3. Toset up aSMARTNET channel, select
“SMARTNET” asthe channel type, and to set up a
SmartZone channel, sdect “ SmartZone”.

4. Click the Modify button to display the dialog box
shown in the lower part of Figure 3-4. This box
programs the alias (tag) that is displayed when it is
selected.

5. Program the other parametersin the main part of the
screen (see information which follows).

3.6.9 SMARTNET/SMARTZONE CHANNEL
SCREEN PARAMETERS

The following parameters are programmed in the
SMARTNET/SmartZone channel screen shownin
Figure 3-4.

Selected Channel

Zone Box - Clicking the arrow to the right of this
box displaysthe available zones. Click on azoneto
select it. Zones and zone aliases are set up on the
Radio-Wide General screen described in Section
34.2.
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Channel Index Box - Displays the channelsin the
selected zone. The channel type is selected by the
Channel Type box below it.

- Displays the screen shown in the

lower part of Figure 3-4. The parameters
programmed in this screen are as follows:

Channel - Selects the channel to be edited.

Alias - Programs the identification that is displayed
when the channel is selected. Upto 8
characters can be programmed.

Transmit - Not programmable because the transmit
frequency is dynamically assigned over the
air (“Trunked” is always displayed).

Receive - Dynamically assigned like the transmit
frequency.

Enable This Channel - Not used because SMART-
NET/SmartZone channels are always
enabled if set up. To disable achannel so
that it is not selectable, choose the conven-
tional type and do not check this box.

Copy Parameters From Channel - If another channel
is selected in the box, the parameters from
that channel are copied to the new channel.

Channél Type

Channel Type Box - Selects the specific system
fromwhich the channel isselected. All programmed
systems are displayed by number and type (conven-
tional, SMARTNET, SmartZone). When adifferent
channel typeis selected, the screen for that type of
channel is automatically displayed.

Other Screen Parameters

System Specific Information - With SMARTNET/
SmartZone systems, indicates the system ID
programmed on the system General screen (see
Section 3.6.2).

Talk Group - Selectsthe talk group selected by that
channel. Talk groups are programmed in the Talk
Group screen described in Section 3.6.5.

Announcement Group - Selects one of up to three
announcement groups selected by the channel.
Refer to “ Announcement Group Screen” in Section
3.6.7 for more information.
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Emergency Group - Selects the talk group used for
emergency calls.

Talk Permit Tone - When enabled, a short tone
sounds after arequest for agroup call has been
approved by the main controller. Thisindicates that
speaking can begin. When disabled, no audio feed-
back is used to indicate when speaking can begin.

System Scan - Selectsthe Priority Monitor Scan list
selected by the channel (see“Priority Monitor Scan

Screen” description in Section 3.6.7). If “No Scan
List” is programmed, scanning is not selectable on
that channel.

Auto Scan - When enabled and achannel is selected,
the radio automatically begins scanning the scan list
associated with that channel. When disabled, scan-
ning can only be started manually by the Scan
option switch.

Table 3-1 Call Guard (CTCSS/DCS) Codes and Tones

Recommended Tone Call Guard Codes

Code Freq Code Freq Code Freq Code Freq Code Freq
01 67.0 10 94.8 19 127.3 28 173.8 37* 241.8
02 719 11** 97.4 20 131.8 29 179.9 38* 250.3
03 74.4 12 100.0 21 136.5 30 186.2 39** 69.3
04 77.0 13 103.5 22 141.3 31 192.8 40** 206.5
05 79.7 14 107.2 23 146.2 32 2035 41** 229.1
06 825 15 110.9 24 1514 33 210.7 42%* 254.1
07 85.4 16 114.8 25 156.7 34* 218.1
08 88.5 17 118.8 26 162.2 35* 225.7
09 915 18 123.0 27 167.9 36* 233.6
* These tones normally are not used because of their close proximity to the voice frequencies
** Thistone is normally not used because it may cause interference with adjacent tones.

Recommended Digital Call Guard Codes
023 065 131 172 261 346 431 532 654 743
025 071 132 174 263 351 432 546 662 754
026 072 134 205 265 364 445 565 664
031 073 143 223 271 365 464 606 703
032 074 152 226 306 371 465 612 712
043 114 155 243 311 411 466 624 723
047 115 156 244 315 412 503 627 731
051 116 162 245 331 413 506 631 732
054 125 165 251 343 423 516 632 734
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800 MHz Channels
FCCChan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. Freq No. Freq. Freq No. Freq Freq
1 851.0125 806.0125 49 852.2125 807.2125 97 853.4125 808.4125
2 851.0375 806.0375 50 852.2375 807.2375 98 853.4375 808.4375
3 851.0625 806.0625 51 852.2625 807.2625 99 853.4625 808.4625
4 851.0875 806.0875 52 852.2875 807.2875 100 853.4875 808.4875
5 851.1125 806.1125 53 852.3125 807.3125 101 853.5125 808.5125
6 851.1375 806.1375 54 852.3375 807.3375 102 853.5375 808.5375
7 851.1625 806.1625 55 852.3625 807.3625 103 853.5625 808.5625
8 851.1875 806.1875 56 852.3875 807.3875 104 853.5875 808.5875
9 851.2125 806.2125 57 852.4125 807.4125 105 853.6125 808.6125
10 851.2375 806.2375 58 852.4375 807.4375 106 853.6375 808.6375
11 851.2625 806.2625 59 852.4625 807.4625 107 853.6625 808.6625
12 851.2875 806.2875 60 852.4875 807.4875 108 853.6875 808.6875
13 851.3125 806.3125 61 852.5125 807.5125 109 853.7125 808.7125
14 851.3375 806.3375 62 852.5375 807.5375 110 853.7375 808.7375
15 851.3625 806.3625 63 852.5625 807.5625 111 853.7625 808.7625
16 851.3875 806.3875 64 852.5875 807.5875 112 853.7875 808.7875
17 851.4125 806.4125 65 852.6125 807.6125 113 853.8125 808.8125
18 851.4375 806.4375 66 852.6375 807.6375 114 853.8375 808.8375
19 851.4625 806.4625 67 852.6625 807.6625 115 853.8625 808.8625
20 851.4875 806.4875 68 852.6875 807.6875 116 853.8875 808.8875
21 851.5125 806.5125 69 852.7125 807.7125 117 853.9125 808.9125
22 851.5375 806.5375 70 852.7375 807.7375 118 853.9375 808.9375
23 851.5625 806.5625 71 852.7625 807.7625 119 853.9625 808.9625
24 851.5875 806.5875 72 852.7875 807.7875 120 853.9875 808.9875
25 851.6125 806.6125 73 852.8125 807.8125 121 854.0125 809.0125
26 851.6375 806.6375 74 852.8375 807.8375 122 854.0375 809.0375
27 851.6625 806.6625 75 852.8625 807.8625 123 854.0625 809.0625
28 851.6875 806.6875 76 852.8875 807.8875 124 854.0875 809.0875
29 851.7125 806.7125 77 852.9125 807.9125 125 854.1125 809.1125
30 851.7375 806.7375 78 852.9375 807.9375 126 854.1375 809.1375
31 851.7625 806.7625 79 852.9625 807.9625 127 854.1625 809.1625
32 851.7875 806.7875 80 852.9875 807.9875 128 854.1875 809.1875
33 851.8125 806.8125 81 853.0125 808.0125 129 854.2125 809.2125
34 851.8375 806.8375 82 853.0375 808.0375 130 854.2375  809.2375
35 851.8625 806.8625 83 853.0625 808.0625 131 854.2625 809.2625
36 851.8875 806.8875 84 853.0875 808.0875 132 854.2875  809.2875
37 851.9125 806.9125 85 853.1125 808.1125 133 854.3125 809.3125
38 851.9375 806.9375 86 853.1375 808.1375 134 854.3375 809.3375
39 851.9625 806.9625 87 853.1625 808.1625 135 854.3625 809.3625
40 851.9875 806.9875 88 853.1875 808.1875 136 854.3875 809.3875
41 852.0125 807.0125 89 853.2125 808.2125 137 854.4125 809.4125
42 852.0375 807.0375 90 853.2375 808.2375 138 854.4375 809.4375
43 852.0625 807.0625 91 853.2625 808.2625 139 854.4625  809.4625
44 852.0875 807.0875 92 853.2875 808.2875 140 854.4875  809.4875
45 852.1125 807.1125 93 853.3125 808.3125 141 854.5125 809.5125
46 852.1375 807.1375 94 853.3375 808.3375 142 854.5375 809.5375
47 852.1625 807.1625 95 853.3625 808.3625 143 854.5625 809.5625
48 852.1875 807.1875 96 853.3875 808.3875 144 854.5875 809.5875
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800 MHz Channels
FCCChan.| Mobile Rx| Mobile Tx FCC Chan.| Maobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freqg. Freq No. Freq. Freq No. Freq Freq
145 854.6125 809.6125 193 855.8125 810.8125 241 857.0125 812.0125
146 854.6375 809.6375 194 855.8375 810.8375 242 857.0375 812.0375
147 854.6625 809.6625 195 855.8625 810.8625 243 857.0625 812.0625
148 854.6875 809.6875 196 855.8875 810.8875 244 857.0875 812.0875
149 854.7125 809.7125 197 855.9125 810.9125 245 857.1125 812.1125
150 854.7375 809.7375 198 855.9375 810.9375 246 857.1375 812.1375
151 854.7625 809.7625 199 855.9625 810.9625 247 857.1625 812.1625
152 854.7875 809.7875 200 855.9875 810.9875 248 857.1875 812.1875
153 854.8125 809.8125 201 856.0125 811.0125 249 857.2125 812.2125
154 854.8375 809.8375 202 856.0375 811.0375 250 857.2375 812.2375
155 854.8625 809.8625 203 856.0625 811.0625 251 857.2625 812.2625
156 854.8875 809.8875 204 856.0875 811.0875 252 857.2875 812.2875
157 854.9125 809.9125 205 856.1125 811.1125 253 857.3125 812.3125
158 854.9375 809.9375 206 856.1375 811.1375 254 857.3375 812.3375
159 854.9625 809.9625 207 856.1625 811.1625 255 857.3625 812.3625
160 854.9875 809.9875 208 856.1875 811.1875 256 857.3875 812.3875
161 855.0125 810.0125 209 856.2125 811.2125 257 857.4125 812.4125
162 855.0375 810.0375 210 856.2375 811.2375 258 857.4375 812.4375
163 855.0625 810.0625 211 856.2625 811.2625 259 857.4625 812.4625
164 855.0875 810.0875 212 856.2875 811.2875 260 857.4875 812.4875
165 855.1125 810.1125 213 856.3125 811.3125 261 857.5125 812.5125
166 855.1375 810.1375 214 856.3375 811.3375 262 857.5375 812.5375
167 855.1625 810.1625 215 856.3625 811.3625 263 857.5625 812.5625
168 855.1875 810.1875 216 856.3875 811.3875 264 857.5875 812.5875
169 855.2125 810.2125 217 856.4125 811.4125 265 857.6125 812.6125
170 855.2375 810.2375 218 856.4375 811.4375 266 857.6375 812.6375
171 855.2625 810.2625 219 856.4625 811.4625 267 857.6625 812.6625
172 855.2875 810.2875 220 856.4875 811.4875 268 857.6875 812.6875
173 855.3125 810.3125 221 856.5125 811.5125 269 857.7125 812.7125
174 855.3375 810.3375 222 856.5375 811.5375 270 857.7375 812.7375
175 855.3625 810.3625 223 856.5625 811.5625 271 857.7625 812.7625
176 855.3875 810.3875 224 856.5875 811.5875 272 857.7875 812.7875
177 855.4125 810.4125 225 856.6125 811.6125 273 857.8125 812.8125
178 855.4375 810.4375 226 856.6375 811.6375 274 857.8375 812.8375
179 855.4625 810.4625 227 856.6625 811.6625 275 857.8625 812.8625
180 855.4875 810.4875 228 856.6875 811.6875 276 857.8875 812.8875
181 855.5125 810.5125 229 856.7125 811.7125 277 857.9125 812.9125
182 855.5375 810.5375 230 856.7375 811.7375 278 857.9375 812.9375
183 855.5625 810.5625 231 856.7625 811.7625 279 857.9625 812.9625
184 855.5875 810.5875 232 856.7875 811.7875 280 857.9875 812.9875
185 855.6125 810.6125 233 856.8125 811.8125 281 858.0125 813.0125
186 855.6375 810.6375 234 856.8375 811.8375 282 858.0375 813.0375
187 855.6625 810.6625 235 856.8625 811.8625 283 858.0625 813.0625
188 855.6875 810.6875 236 856.8875 811.8875 284 858.0875 813.0875
189 855.7125 810.7125 237 856.9125 811.9125 285 858.1125 813.1125
190 855.7375 810.7375 238 856.9375 811.9375 286 858.1375 813.1375
191 855.7625 810.7625 239 856.9625 811.9625 287 858.1625 813.1625
192 855.7875 810.7875 240 856.9875 811.9875 288 858.1875 813.1875
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800 MHz Channels
FCCChan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. Freq No. Freq. Freq No. Freq Freq

289 858.2125 813.2125 337 859.4125 814.4125 385 860.6125 815.6125
290 858.2375 813.2375 338 859.4375 814.4375 386 860.6375 815.6375
291 858.2625 813.2625 339 859.4625 814.4625 387 860.6625 815.6625
292 858.2875 813.2875 340 859.4875 814.4875 388 860.6875 815.6875
293 858.3125 813.3125 341 859.5125 814.5125 389 860.7125 815.7125
294 858.3375 813.3375 342 859.5375 814.5375 390 860.7375 815.7375
295 858.3625 813.3625 343 859.5625 814.5625 391 860.7625 815.7625
296 858.3875 813.3875 344 859.5875 814.5875 392 860.7875 815.7875
297 858.4125 813.4125 345 859.6125 814.6125 393 860.8125 815.8125
298 858.4375 813.4375 346 859.6375 814.6375 394 860.8375 815.8375
299 858.4625 813.4625 347 859.6625 814.6625 395 860.8625 815.8625
300 858.4875 813.4875 348 859.6875 814.6875 396 860.8875 815.8875
301 858.5125 813.5125 349 8590.7125 814.7125 397 860.9125 815.9125
302 858.5375 813.5375 350 859.7375 814.7375 398 860.9375 815.9375
303 858.5625 813.5625 351 859.7625 814.7625 399 860.9625 815.9625
304 858.5875 813.5875 352 8590.7875 814.7875 400 860.9875 815.9875
305 858.6125 813.6125 353 8590.8125 814.8125 401 861.0125 816.0125
306 858.6375 813.6375 354 859.8375 814.8375 402 861.0375 816.0375
307 858.6625 813.6625 355 859.8625 814.8625 403 861.0625 816.0625
308 858.6875 813.6875 356 859.8875 814.8875 404 861.0875 816.0875
309 858.7125 813.7125 357 850.9125 814.9125 405 861.1125 816.1125
310 858.7375 813.7375 358 859.9375 814.9375 406 861.1375 816.1375
311 858.7625 813.7625 359 859.9625 814.9625 407 861.1625 816.1625
312 858.7875 813.7875 360 859.9875 814.9875 408 861.1875 816.1875
313 858.8125 813.8125 361 860.0125 815.0125 409 861.2125 816.2125
314 858.8375 813.8375 362 860.0375 815.0375 410 861.2375 816.2375
315 858.8625 813.8625 363 860.0625 815.0625 411 861.2625 816.2625
316 858.8875 813.8875 364 860.0875 815.0875 412 861.2875 816.2875
317 858.9125 813.9125 365 860.1125 815.1125 413 861.3125 816.3125
318 858.9375 813.9375 366 860.1375 815.1375 414 861.3375 816.3375
319 858.9625 813.9625 367 860.1625 815.1625 415 861.3625 816.3625
320 858.9875 813.9875 368 860.1875 815.1875 416 861.3875 816.3875
321 859.0125 814.0125 369 860.2125 815.2125 417 861.4125 816.4125
322 859.0375 814.0375 370 860.2375 815.2375 418 861.4375 816.4375
323 859.0625 814.0625 371 860.2625 815.2625 419 861.4625 816.4625
324 859.0875 814.0875 372 860.2875 815.2875 420 861.4875 816.4875
325 8590.1125 814.1125 373 860.3125 815.3125 421 861.5125 816.5125
326 859.1375 814.1375 374 860.3375 815.3375 422 861.5375 816.5375
327 859.1625 814.1625 375 860.3625 815.3625 423 861.5625 816.5625
328 859.1875 814.1875 376 860.3875 815.3875 424 861.5875 816.5875
329 8590.2125 814.2125 377 860.4125 815.4125 425 861.6125 816.6125
330 859.2375 814.2375 378 860.4375 815.4375 426 861.6375 816.6375
331 859.2625 814.2625 379 860.4625 815.4625 427 861.6625 816.6625
332 850.2875  814.2875 380 860.4875 815.4875 428 861.6875 816.6875
333 850.3125 814.3125 381 860.5125 815.5125 429 861.7125 816.7125
334 859.3375 814.3375 382 860.5375 815.5375 430 861.7375 816.7375
335 859.3625 814.3625 383 860.5625 815.5625 431 861.7625 816.7625
336 859.3875 814.3875 384 860.5875 815.5875 432 861.7875 816.7875
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800 MHz Channels
FCCChan.| Mobile Rx| Mobile Tx FCC Chan.| Maobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freqg. Freq No. Freq. Freq No. Freq Freq
433 861.8125 816.8125 481 863.0125 818.0125 529 864.2125 819.2125
434 861.8375 816.8375 482 863.0375 818.0375 530 864.2375 819.2375
435 861.8625 816.8625 483 863.0625 818.0625 531 864.2625 819.2625
436 861.8875 816.8875 484 863.0875 818.0875 532 864.2875 819.2875
437 861.9125 816.9125 485 863.1125 818.1125 533 864.3125 819.3125
438 861.9375 816.9375 486 863.1375 818.1375 534 864.3375 819.3375
439 861.9625 816.9625 487 863.1625 818.1625 535 864.3625 819.3625
440 861.9875 816.9875 488 863.1875 818.1875 536 864.3875 819.3875
441 862.0125 817.0125 489 863.2125 818.2125 537 864.4125 819.4125
442 862.0375 817.0375 490 863.2375 818.2375 538 864.4375 819.4375
443 862.0625 817.0625 491 863.2625 818.2625 539 864.4625 819.4625
444 862.0875 817.0875 492 863.2875 818.2875 540 864.4875 819.4875
445 862.1125 817.1125 493 863.3125 818.3125 541 864.5125 819.5125
446 862.1375 817.1375 494 863.3375 818.3375 542 864.5375 819.5375
447 862.1625 817.1625 495 863.3625 818.3625 543 864.5625 819.5625
448 862.1875 817.1875 496 863.3875 818.3875 544 864.5875 819.5875
449 862.2125 817.2125 497 863.4125 818.4125 545 864.6125 819.6125
450 862.2375 817.2375 498 863.4375 818.4375 546 864.6375 819.6375
451 862.2625 817.2625 499 863.4625 818.4625 547 864.6625 819.6625
452 862.2875 817.2875 500 863.4875 818.4875 548 864.6875 819.6875
453 862.3125 817.3125 501 863.5125 818.5125 549 864.7125 819.7125
454 862.3375 817.3375 502 863.5375 818.5375 550 864.7375 819.7375
455 862.3625 817.3625 503 863.5625 818.5625 551 864.7625 819.7625
456 862.3875 817.3875 504 863.5875 818.5875 552 864.7875 819.7875
457 862.4125 817.4125 505 863.6125 818.6125 553 864.8125 819.8125
458 862.4375 817.4375 506 863.6375 818.6375 554 864.8375 819.8375
459 862.4625 817.4625 507 863.6625 818.6625 555 864.8625 819.8625
460 862.4875 817.4875 508 863.6875 818.6875 556 864.8875 819.8875
461 862.5125 817.5125 509 863.7125 818.7125 557 864.9125 819.9125
462 862.5375 817.5375 510 863.7375 818.7375 558 864.9375 819.9375
463 862.5625 817.5625 511 863.7625 818.7625 559 864.9625 819.9625
464 862.5875 817.5875 512 863.7875 818.7875 560 864.9875 819.9875
465 862.6125 817.6125 513 863.8125 818.8125 561 865.0125 820.0125
466 862.6375 817.6375 514 863.8375 818.8375 562 865.0375 820.0375
467 862.6625 817.6625 515 863.8625 818.8625 563 865.0625 820.0625
468 862.6875 817.6875 516 863.8875 818.8875 564 865.0875 820.0875
469 862.7125 817.7125 517 863.9125 818.9125 565 865.1125 820.1125
470 862.7375 817.7375 518 863.9375 818.9375 566 865.1375 820.1375
471 862.7625 817.7625 519 863.9625 818.9625 567 865.1625 820.1625
472 862.7875 817.7875 520 863.9875 818.9875 568 865.1875 820.1875
473 862.8125 817.8125 521 864.0125 819.0125 569 865.2125 820.2125
474 862.8375 817.8375 522 864.0375 819.0375 570 865.2375 820.2375
475 862.8625 817.8625 523 864.0625 819.0625 571 865.2625 820.2625
476 862.8875 817.8875 524 864.0875 819.0875 572 865.2875 820.2875
477 862.9125 817.9125 525 864.1125 819.1125 573 865.3125 820.3125
478 862.9375 817.9375 526 864.1375 819.1375 574 865.3375 820.3375
479 862.9625 817.9625 527 864.1625 819.1625 575 865.3625 820.3625
480 862.9875 817.9875 528 864.1875 819.1875 576 865.3875 820.3875
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800 MHz Channels
FCCChan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. Freq No. Freq. Freq No. Freq Freq
577 865.4125 820.4125 623 866.3000 821.3000 669 866.9000 821.9000
578 865.4375 820.4375 624 866.3125 821.3125 670 866.9125 821.9125
579 865.4625 820.4625 625 866.3250 821.3250 671 866.9250 821.9250
580 865.4875 820.4875 626 866.3375 821.3375 672 866.9375 821.9375
581 865.5125 820.5125 627 866.3500 821.3500 673 866.9500 821.9500
582 865.5375 820.5375 628 866.3625 821.3625 674 866.9625 821.9625
583 865.5625 820.5625 629 866.3750 821.3750 675 866.9750 821.9750
584 865.5875 820.5875 630 866.3875 821.3875 676 866.9875 821.9875
585 865.6125 820.6125 631 866.4000 821.4000 - 867.0000 822.0000
586 865.6375 820.6375 632 866.4125 821.4125 677 867.0125 822.0125
587 865.6625 820.6625 633 866.4250 821.4250 - 867.0250 822.0250
588 865.6875 820.6875 634 866.4375 821.4375 678 867.0375 822.0375
589 865.7125 820.7125 635 866.4500 821.4500 679 867.0500 822.0500
590 865.7375 820.7375 636 866.4625 821.4625 680 867.0625 822.0625
501 865.7625 820.7625 637 866.4750 821.4750 681 867.0750 822.0750
592 865.7875 820.7875 638 866.4875 821.4875 682 867.0875 822.0875
593 865.8125 820.8125 - 866.5000 821.5000 683 867.1000 822.1000
594 865.8375 820.8375 639 866.5125 821.5125 684 867.1125 822.1125
595 865.8625 820.8625 - 866.5250 821.5250 685 867.1250 822.1250
596 865.8875 820.8875 640 866.5375 821.5375 686 867.1375 822.1375
597 865.9125 820.9125 641 866.5500 821.5500 687 867.1500 822.1500
598 865.9375 820.9375 642 866.5625 821.5625 688 867.1625 822.1625
599 865.9625 820.9625 643 866.5750 821.5750 689 867.1750 822.1750
600 865.9875 820.9875 644 866.5875 821.5875 690 867.1875 822.1875
- 866.0000 821.0000 645 866.6000 821.6000 691 867.2000 822.2000
601 866.0125 821.0125 646 866.6125 821.6125 692 867.2125 822.2125
- 866.0250 821.0250 647 866.6250 821.6250 693 867.2250 822.2250
602 866.0375 821.0375 648 866.6375 821.6375 694 867.2375 822.2375
603 866.0500 821.0500 649 866.6500 821.6500 695 867.2500 822.2500
604 866.0625 821.0625 650 866.6625 821.6625 696 867.2625 822.2625
605 866.0750 821.0750 651 866.6750 821.6750 697 867.2750 822.2750
606 866.0875 821.0875 652 866.6875 821.6875 698 867.2875 822.2875
607 866.1000 821.1000 653 866.7000 821.7000 699 867.3000 822.3000
608 866.1125 821.1125 654 866.7125 821.7125 700 867.3125 822.3125
609 866.1250 821.1250 655 866.7250 821.7250 701 867.3250 822.3250
610 866.1375 821.1375 656 866.7375 821.7375 702 867.3375 822.3375
611 866.1500 821.1500 657 866.7500 821.7500 703 867.3500 822.3500
612 866.1625 821.1625 658 866.7625 821.7625 704 867.3625 822.3625
613 866.1750 821.1750 659 866.7750 821.7750 705 867.3750 822.3750
614 866.1875 821.1875 660 866.7875 821.7875 706 867.3875 822.3875
615 866.2000 821.2000 661 866.8000 821.8000 707 867.4000 822.4000
616 866.2125 821.2125 662 866.8125 821.8125 708 867.4125 822.4125
617 866.2250 821.2250 663 866.8250 821.8250 709 867.4250 822.4250
618 866.2375 821.2375 664 866.8375 821.8375 710 867.4375 822.4375
619 866.2500 821.2500 665 866.8500 821.8500 711 867.4500 822.4500
620 866.2625 821.2625 666 866.8625 821.8625 712 867.4625 822.4625
621 866.2750 821.2750 667 866.8750 821.8750 713 867.4750 822.4750
622 866.2875 821.2875 668 866.8875 821.8875 714 867.4875 822.4875
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PROGRAMMING

800 MHz Channels
FCCChan.| Mobile Rx| Mobile Tx FCC Chan.| Maobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freqg. Freq No. Freq. Freq No. Freq Freq

- 867.5000 822.5000 759 868.1000 823.1000 807 868.7000 823.7000
715 867.5125 822.5125 760 868.1125 823.1125 808 868.7125 823.7125
- 867.5250 822.5250 761 868.1250 823.1250 809 868.7250 823.7250
716 867.5375 822.5375 762 868.1375 823.1375 810 868.7375 823.7375
717 867.5500 822.5500 763 868.1500 823.1500 811 868.7500 823.7500
718 867.5625 822.5625 764 868.1625 823.1625 812 868.7625 823.7625
719 867.5750 822.5750 765 868.1750 823.1750 813 868.7750 823.7750
720 867.5875 822.5875 766 868.1875 823.1875 814 868.7875 823.7875
721 867.6000 822.6000 767 868.2000 823.2000 815 868.8000 823.8000
722 867.6125 822.6125 768 868.2125 823.2125 816 868.8125 823.8125
723 867.6250 822.6250 769 868.2250 823.2250 817 868.8250 823.8250
724 867.6375 822.6375 770 868.2375 823.2375 818 868.8375 823.8375
725 867.6500 822.6500 771 868.2500 823.2500 819 868.8500 823.8500
726 867.6625 822.6625 772 868.2625 823.2625 820 868.8625 823.8625
727 867.6750 822.6750 773 868.2750 823.2750 821 868.8750 823.8750
728 867.6875 822.6875 774 868.2875 823.2875 822 868.8875 823.8875
729 867.7000 822.7000 775 868.3000 823.3000 823 868.9000 823.9000
730 867.7125 822.7125 776 868.3125 823.3125 824 868.9125 823.9125
731 867.7250 822.7250 777 868.3250 823.3250 825 868.9250 823.9250
732 867.7375 822.7375 778 868.3375 823.3375 826 868.9375 823.9375
733 867.7500 822.7500 779 868.3500 823.3500 827 868.9500 823.9500
734 867.7625 822.7625 780 868.3625 823.3625 828 868.9625 823.9625
735 867.7750 822.7750 781 868.3750 823.3750 829 868.9750 823.9750
736 867.7875 822.7875 782 868.3875 823.3875 830 868.9875 823.9875
737 867.8000 822.8000 783 868.4000 823.4000 - 869.0000 824.0000
738 867.8125 822.8125 784 868.4125 823.4125 - 869.0125 824.0125
739 867.8250 822.8250 785 868.4250 823.4250 - 869.0250 824.0250
740 867.8375 822.8375 786 868.4375 823.4375 - 869.0375 824.0375
741 867.8500 822.8500 787 868.4500 823.4500 - 869.0500 824.0500
742 867.8625 822.8625 788 868.4625 823.4625 - 869.0625 824.0625
743 867.8750 822.8750 789 868.4750 823.4750 - 869.0750 824.0750
744 867.8875 822.8875 790 868.4875 823.4875 - 869.0875 824.0875
745 867.9000 822.9000 791 868.5000 823.5000 - 869.1000 824.1000
746 867.9125 8229125 792 868.5125 823.5125 - 869.1125 824.1125
747 867.9250 822.9250 793 868.5250 823.5250 - 869.1250 824.1250
748 867.9375 822.9375 794 868.5375 823.5375 - 869.1375 824.1375
749 867.9500 822.9500 795 868.5500 823.5500 - 869.1500 824.1500
750 867.9625 822.9625 796 868.5625 823.5625 - 869.1625 824.1625
751 867.9750 822.9750 797 868.5750 823.5750 - 869.1750 824.1750
752 867.9875 822.9875 798 868.5875 823.5875 - 869.1875 824.1875
- 868.0000 823.0000 799 868.6000 823.6000 - 869.2000 824.2000
753 868.0125 823.0125 800 868.6125 823.6125 - 869.2125 824.2125
- 868.0250 823.0250 801 868.6250 823.6250 - 869.2250 824.2250
754 868.0375 823.0375 802 868.6375 823.6375 - 869.2375 824.2375
755 868.0500 823.0500 803 868.6500 823.6500 - 869.2500 824.2500
756 868.0625 823.0625 804 868.6625 823.6625 - 869.2625 824.2625
757 868.0750 823.0750 805 868.6750 823.6750 - 869.2750 824.2750
758 868.0875 823.0875 806 868.6875 823.6875 - 869.2875 824.2875
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PROGRAMMING

800 MHz Channels
FCCChan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx FCC Chan.| Mobile Rx| Mobile Tx
No. Freq. Freq No. Freq. Freq No. Freq Freq

- 869.3000 824.3000 - 869.5375 824.5375 - 869.7750 824.7750
- 869.3125 824.3125 - 869.5500 824.5500 - 869.7875 824.7875
- 869.3250 824.3250 - 869.5625 824.5625 - 869.8000 824.8000
- 869.3375 824.3375 - 869.5750 824.5750 - 869.8125 824.8125
- 869.3500 824.3500 - 869.5875 824.5875 - 869.8250 824.8250
- 869.3625 824.3625 - 869.6000 824.6000 - 869.8375 824.8375
- 869.3750 824.3750 - 869.6125 824.6125 - 869.8500 824.8500
- 869.3875 824.3875 - 869.6250 824.6250 - 869.8625 824.8625
- 869.4000 824.4000 - 869.6375 824.6375 - 869.8750 824.8750
- 869.4125 824.4125 - 869.6500 824.6500 - 869.8875 824.8875
- 869.4250 824.4250 - 869.6625 824.6625 - 869.9000 824.9000
- 869.4375 824.4375 - 869.6750 824.6750 - 869.9125 824.9125
- 869.4500 824.4500 - 869.6875 824.6875 - 869.9250 824.9250
- 869.4625 824.4625 - 869.7000 824.7000 - 869.9375 824.9375
- 869.4750 824.4750 - 869.7125 824.7125 - 869.9500 824.9500
- 869.4875 824.4875 - 869.7250 824.7250 - 869.9625 824.9625
- 869.5000 824.5000 - 869.7375 824.7375 - 869.9750 824.9750
- 869.5125 824.5125 - 869.7500 824.7500 - 869.9875 824.9875
- 869.5250 824.5250 - 869.7625 824.7625
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ALIGNMENT AND PERFORMANCE TESTS

SECTION 4 ALIGNMENT AND PERFORMANCE TESTS

PC-Compatible
Computer

Remote Programming Interface (RPI)
Part No. 023-9800-000

4.7-ohm 13.6 VDC
Speaker Load Power Supply

o[\ 1]
©0 0®o

Ign Sense
(Optional)

o

o

O~

©09% 0 4 H 50-ohm
Load
000000
400080000
Signal Generator/
Comm. Monitor
Figure 4-1 Alignment Setup
4.1 GENERAL With 800 MHz models, only three or four adjust-

4.1.1 INTRODUCTION

The alignment procedure described in this section
should be performed if repairs are made that could
affect the factory alignment. In addition, before a
transceiver isinitialy placed in service, the perfor-
mance tests described in Section 4.8 should be
performed.

To perform the alignment described in this
section, special PCTune software (see Table 1-1) and
the same basic computer setup used for programming
is required. This equipment is shown above and also
described in Section 3.1. Remote Programming Inter-
face (RPI), Part No. 023-9800-000, or others can be
used (except 023-5300-000). The speaker and micro-
phone audio jacks on the 9800 RPI are not required in
this application.

4-1

ments are made manually and the others are made
digitally using the PCTune software. The manual
adjustmentstune the | F and high power PA, and set the
TCXO frequency. If they do not need to be reset, the
transceiver can be tuned without removing the top or
bottom covers.

Thistransceiver does not have a special test mode
that is selected. The PCTune software automatically
selects the frequencies and other test conditions that
are required to perform the alignment. If the trans-
ceiver must be controlled manually to perform such
things as testing or troubleshooting, program tempo-
rary conventional channels.

4.1.2 TEST SETUP

Connect the test setup shown in Figure 4-1. Addi-
tional information follows on equipment in this setup.
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ALIGNMENT AND PERFORMANCE TESTS

RF Signal Generator - When connecting the gener-
ator to the antenna jack, use at least a 6 dB pad
between the generator and transceiver. This protects
the generator if the transmitter is accidentally keyed
and also ensures that a 50-ohm load exists. The input
levelslisted in the PCTune screens are at the antenna
jack, so increase the generator output accordingly.

Power Source- Typical current when transmittingis 7
amperes with 15-watt moddls, and 11 amperes with
30-watt models. Therefore, a power supply capable of
producing that current at 13.6 voltsis required.

Wattmeter/L oad - The wattmeter and dummy |oad
must measure and dissipate up to approximately 30
walts. For accurate power output measurement at 800
MHz, use a minimum number of connectors with a
Teflon or better dielectric. If coaxial cableisused, it
should be a minimum length of alow-loss type.

Speaker Load - The speaker load is connected to the
1/8" phone jack on the back of the transceiver.

Computer and RPI - The RPI is connected to the
computer and transceiver as described in Section
3.1.4. RPI, Part No. 023-9800-000 or other RPIs
(except 023-5300-000) can be used as described in the
preceding section.

4.1.3 TUNE SOFTWARE
General

The PCTune software is a Windows®-based
program. Minimum software and hardware require-
ments are as follows:

* Windows® 95 or 3.1

386SX or faster microprocessor

4 megabytes of RAM

3 megabytes free space available on hard drive
An available serial port

Software | nstallation

Proceed as follows to install this software:

1. Close all applications that are currently running
(other than Windows).
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2. Insert the disk containing the PCTune softwarein
drive A: (or B:).

3. From the Windows 95 taskbar, choose RUN and
open SETURPEXE ondriveA: (or B:). Alternatively,
use File Explorer and double click SETURPEXE.

From the Windows 3.1 Program Manager, choose
FILE > RUN and select the SETUPEXE fileon
drive A: (or B:).

4. Follow theinstructions on the screen. The program
is automatically loaded on the hard drive and start-
up shortcuts or groups are created.

Starting PCTune

From Windows 95 - Select Start in the taskbar, then
Programs > PCTune > PCTune.

From Windows 3.1 - From the Program Manager,
open the PCTune group and then double click the
PCTune icon.

Exiting PCTune

Select File > Exit or click the “X” button on the
right end of thetitle bar.

4.1.4 PRELIMINARY SETUP

1. With transceiver power turned off, connect the RPI
to an unused serial port of the computer. Then
connect the RPI to the microphone jack of thetrans-
ceiver (see Section 3.1.4).

2. Start the PCTune program as described in the
preceding section. If required, select the serial port
being used by selecting Options > Set Comm Port.

3. Turn transceiver power on and the green indicator
onthe RPI should light. Move the sel ector switch on
the RPI to the other position if thisindicator is
amber.

4. Follow theinstructions on the screen to display the
main screen shown in Figure 4-2. Select Tuning >
Complete Tuning to automatically step through a
complete alignment or Tuning > Partial Tuning to
manually select each adjustment.



ALIGNMENT AND PERFORMANCE TESTS

B FCTune
Eile Tuning Options Help
Tuning Type: | Partial Tz Power Level

Status:

Instructions:

1 15 Watt [98:0¢-1042)
(8 30 Watt [98:0{-x043)

Frequency Band

(@:800 Mhz _[806 - 570 Mhz):

Latest Walue: |

Select test from "Tuning Options" check box.

C
Tuning Options
T Paweer
i~ Frequency Set - VCO Checl
" Tx Modulation
i~ Receiver |F Adjustment
" ¥ Check.
i~ Squelch
™ RS5I

Figure 4-2 PCTune Main Screen

. The computer then attempts to establish communi-
cation with thetransceiver. When communicationis
established, “Com Link Established” isdisplayedin
the* Status” box and “TUNING” isindicated in the
transceiver display. Instructions are then displayed
in the “Ingtructions’ box on how to proceed with
each adjustment.

Tune Parameters

Software
DSP code Version  [1 23 HC11 code Yersion [1
T Power RS5I
825.0000 MHz [16 ' atts) 70
— FO0000MHz (13 wats)  [r7 | | niested
= Paar 0
825.0000 MHz [2 ' atts]
Ed Acceptable 118
it Squelch
ﬁ wiide Band Marrow Band Eeed 138
Squelched 10915 5905 “wide Band 180
Set Defaults Unzquelched [1932 350 Excellent 163
T Modulatior
80E.0125 MH=2 851.0125 MH=
Set RSSI 3000 Hz 166 3000 Hz 132
Defaults Only
1000 Hz 218 1000 Hz 218
215.0125 MH=z BE0.0125 MH=
3000 Hz 159 3000 Hz 127
1000 Hz 219 1000 Hz 218
824.0125 MH= BE3.0125 MH=
3000 Hz 154 3000 Hz 120
1000 Hz 219 1000 Hz 7

Figure 4-3 Tune Parameters Screen
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4.1.5 READING CURRENT SETTINGS

To read and display the settings currently

programmed in atransceiver, select Tuning > Display
Tune Parameters from the Menu bar. The screenin
Figure 4-3 is then displayed. The following functions
can be performed from this screen:

To read the settings in the transceiver from this
screen, click the “Read” button.

To writethe settingsin this screen to thetransceiver,
click the “Write” button.

To set all parametersin thisscreen to adefault level,
click the “Set Defaults’ button.

To set only the RSS! levelsto the default level, click
the “ Set RSSI Defaults Only” button.

4.2 TRANSMIT POWER OUTPUT

1. Connect awattmeter and 50-ohm load to the

antennajack as shown in Figure 4-1. Manually or
automatically select “Tx Power” and follow the on-
screen instructions.
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With high power (30W) models only, C656 on the
PA board is adjusted for minimum current. Remove
the bottom cover and adjust C656 as required.

Adjust for the displayed power output at various
frequencies across the band. A high and low power
output level is set by this function. The allowable
power output range for each model is as follows:

Mid Power (15W) Models - 2-15 watts
High Power (30W) Models - 10-30 watts

4.3 FREQUENCY SET/VCO CHECK

1.

Connect a50-ohm load to the antenna jack and
monitor the transmit signal with acommunication
monitor.

Select the Frequency Set/V CO Check function. Set
the communication monitor to the displayed
frequency and click the“OK” button to key the
transmitter and begin the adjustment process.

If adjustment is required, remove the top cover of
the transceiver to access the RF board. Then manu-
ally adjust the variable capacitor in reference
oscillator U806 for the displayed frequency +100
Hz (see Figure 4-4). This aso setsthe receive
frequency.

TheV CO control line voltage can be checked for the
indicated readings at thejunction of R848 and C836.
If it isnot within the indicated limits, there may be
asynthesizer problem or the VCO may be defective.
The control voltage is not adjustable.

4.4 TRANSMIT MODULATION

Transmit modulation is set by balancing the

modulation produced by 80 Hz and 3 kHz tones and
then setting modulation limiting using a 1 kHz tone.
All of these tones areinternally generated by the trans-
ceiver, so no external audio generator is required.
Proceed as follows:

1.

Connect a50-ohm load to the antenna jack and
monitor the transmit signal with acommunication
monitor. Manually or automatically select “ Tx
Modulation”.
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2. Set the communication monitor for the displayed

frequency and then click “OK” to transmit a signal
modulated with an 80 Hz tone. Enter the measured
deviation (in hertz) in the displayed box and click
“OK”.

. Continue following the screen instructions to adjust

the 3 kHz tone deviation. The + and — buttons are
clicked to set the deviation to the indicated level.
The 1 kHz tone is then adjusted.

. The preceding 3 kHz and 1 kHz tone adjustments

are then repeated on several frequencies across the
band. After the last adjustment is made, the trans-
mitter unkeys and the settings are stored.

Reag/cg3s  J201
‘ Pin 20 Pin 19

Ref Osc Freq.

L218 L215 L213

Figure 4-4 Alignment Points Diagram
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4.5 RECEIVER IF ALIGNMENT AND CHECK

1. If required, remove the top cover of the transceiver
to access the RF board. Manually or automatically
select “Receiver |F Alignment”.

2. Connect an RF signal generator to the antennajack
using a6 dB or greater pad. Set the generator output
for the displayed frequency, modulated with 1 kHz
at 3 kHz deviation.

3. Connect the DC voltmeter to J201, pin 20 (see
Figure 4-4). Set the generator output level for —47
dBm (1.0 mV) at the antenna jack. and manually
adjust L218 for ameter reading of 29V £0.1 V.

4. Set the generator output level for =80 dBm (22 V)
at the antenna jack. Connect a SINAD meter to the
speaker jack on the back of the transceiver and
adjust the volume level to approximately 1/3 of the
maximum level. Click “OK” and manually adjust
L213 and L215 for best SINAD.

5. Manually or automatically select “ Receiver Check”.
Follow the instructions to check SINAD sensitivity
on the low, mid, and high channels indicated. Click
the Wide Band/Narrow Band button to switch the
selected bandwidth. Use 3 kHz deviation for wide
band channels and 1.5 kHz deviation for narrow
band channels.

4.6 SQUELCH ADJUSTMENT

1. Connect an RF signal generator to the antenna jack
using a6 dB or greater pad. Also connect a SINAD
meter to the speaker jack and adjust the volume to
1/3 maximum if required.

2. Manually or automatically select “ Squelch”. Set the
signal generator for the indicated frequency and
modulation and adjust the output level for the indi-
cated SINAD level.

3. Follow the instructions on the screen to adjust the
wide and narrow band squelch level.

4.7 RSSI ADJUSTMENT

This adjustment calibrates the RSSI signal level.
Proceed as follows:

4-5

1. Manually or automatically select “RSSI”. Connect
an RF signal generator to the antennajack using a6
dB or greater pad and set it for the displayed
frequency and output level.

2. Follow the instructions displayed on the screen.

4.8 PERFORMANCE TESTING

Performance testing can be accomplished by
programming temporary conventional channels and
then checking receiver and transmitter operation on
those channels. Channél s should be programmed at the
low, mid, and high ends of the operating band.

The PCTune software described in the preceding
information can also be used for basic performance
testing. Transmitter power output can be checked as
described in Section 4.2, and receiver sensitivity can
be checked as described in Section 4.5.

Receiver and transmitter specifications you may
want to check are asfollows:

Receiver Specifications

12 dB SINAD Sensitivity - 0.35 g4V maximum

Audio Power Output - 5 watts (w/external 4.7-ohm
load)

Audio Distortion - Less than 5%

Transmitter Specifications

RF Power Output:
15-Watt Models - 2-15 watts
30-Watt Models - 10-30 watts

Wideband Deviation:
Voice Only - 3.0 kHz +100 Hz
Data Only -1000 Hz £100 Hz
Total Voice and Data - 4.7 kHz maximum

Narrow Band Deviation:
Voice Only - 1.2 kHz +100 Hz
Data Only - 800 Hz £100 Hz
Total Voice and Data - 2.3 kHz maximum
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SECTION 5 DSP BOARD SERVICING INFORMATION

98xx Audio/Logic Board Part Changes

Ref No. Description Part No.
ADDED PARTS
J310 |10-pinsinglein-line header 515-7100-010

J311 |10-pinsinglein-line header 515-7100-010
DELETED PARTS
L ocation
C335 [J302,pin9 510-2625-479
R 354 |U301D, pin 14 output jumper 569-0115-001
R 383 |U303D, pin 14 output jumper 569-0115-001
U 102 (U101, pin 32 (4K x 8 EEPROM) |544-5001-416
98xx RF Board Part Change
Ref No. Description Part No.
J201 | 20-pin connector, .82" pinmale  |515-7103-060
DSP Board Parts List

Ref No. Description Part No.

C001 |100nF X7R +10% 50V cer smd |510-3605-104
C002 |100nF X7R +10% 50V cer smd |510-3605-104
C003 |100 nF X7R +10% 50V cer smd |510-3605-104
C004 |10 pF low ESR tantalum 510-2610-100,
CQ005 |10 pFlow ESR tantalum 510-2610-100,
C006 |[100 nF X7R +10% 50V cer snd |510-3605-104
C 007 |.001 uF NPO £5% cer smd 510-3601-102
C 008 |4.7 uF £10% 50V tantalum 510-2622-479
C 009 |[390 pF +5% NPO 50V cersmd  [510-3601-391
C 010 |390 pF +5% NPO 50V cer smd 510-3601-391
C011 |4.7 uF £10% 50V tantalum 510-2622-479
C012 |[390 pF +5% NPO 50V cersmd  |510-3601-391
C 013 |390 pF +5% NPO 50V cer smd 510-3601-391
C014 |4.7 uF £10% 50V tantalum 510-2622-479
CO015 |100 nF X7R +10% 50V cer smd |510-3605-104
C016 |.001 pF NPO £5% 50V cer smd |510-3601-102
C017 |10 pFlow ESR tantalum 510-2610-100,
C018 |10 pFlow ESR tantalum 510-2610-100
C019 |100nF X7R +10% 50V cer smd |510-3605-104
C020 |100nF X7R +10% 50V cer smd |510-3605-104
C021 |.001 uF NPO £5% 50V cer smd |510-3601-102
C022 |100nF X7R +10% 50V cer smd |510-3605-104

Ref No. Description Part No.

C023 |100 nF X7R +10% 50V cer smd |510-3605-104
C024 |.001 uF NPO £5% 50V cer smd  |510-3601-102
C025 |100nF X7R +10% 50V cer smd |510-3605-104
C026 (100 nF X7R +10% 50V cer smd  |510-3605-104
C027 |100 pF 16V tantalum smd 510-2616-101
C028 |100 pF 16V tantalum smd 510-2616-101
C029 (100 pF 16V tantalum smd 510-2616-101
CO030 (10 pFlow ESR tantalum 510-2610-100
C031 |100nF X7R +10% 50V cer smd |510-3605-104
C032 |100 nF X7R +10% 50V cer smd |510-3675-104
C033 |100 nF X7R +10% 50V cer smd |510-3605-104
C034 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C035 |100 nF X7R +10% 50V cer smd |510-3605-104
C036 |.001 pF NPO £5% 50V cer smd |510-3601-102
C037 |100nF X7R +10% 50V cer smd |510-3605-104
C038 (100 nF X7R +10% 50V cer smd  |510-3605-104
C039 |100nF X7R +10% 50V cer smd |510-3605-104
C041 |470 pF X7R +10% 50V cer smd  |510-3605-471
C 042 |470 pF X7R +10% 50V cer smd |510-3605-471
C044 |100 nF X7R +10% 50V cer smd  |510-3605-104
C045 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C046 |100 nF X7R +10% 50V cer smd |510-3605-104
C 047 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C048 |100 nF X7R +10% 50V cer smd  |510-3605-104
C049 |.001 uF NPO £5% 50V cersmd  |510-3601-102
C050 |100nF X7R +10% 50V cer smd |510-3605-104
C051 |.001 pF NPO £5% 50V cer smd |510-3601-102
C052 |100 nF X7R +10% 50V cer smd |510-3605-104
C053 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C054 |100nF X7R +10% 50V cer smd |510-3605-104
C055 |.001 uF NPO £5% 50V cer smd  |510-3601-102
C056 |100nF X7R +10% 50V cer smd |510-3605-104
C057 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C058 |100 nF X7R +10% 50V cer smd |510-3605-104
C059 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C060 |100nF X7R +10% 50V cer smd |510-3605-104
C061 |.001 uF NPO £5% 50V cersmd  |510-3601-102
C062 |100nF X7R +10% 50V cer smd |510-3605-104
C063 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C064 |100 nF X7R +10% 50V cer smd |510-3605-104
C065 |.001 pF NPO £5% 50V cer smd  |510-3601-102
C066 |100nF X7R +10% 50V cer smd |510-3605-104
C067 |.001 uF NPO £5% 50V cer smd  |510-3601-102
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DSP BOARD SERVICING INFORMATION

DSP BOARD PARTS LIST (CONT’D)

Ref No. Description Part No. Ref No. Description Part No.
FOOL |Fuse, 0.6A smd 534-5001-002]  [R022 |10k ohm £5% 1/8W smd 560-0105-103
R023 |10k ohm 5% 1/8W smd 560-0105-103
D001 |Dual switch-com cathode 523-1504-022]  [R024 |10k ohm £5% 1/8W smd 569-0105-103
R025 |10k ohm 5% 1/8W smd 560-0105-103
MP 182|Washer, insulated #6 fiber 596-4406-010|  [R026 |2.0k ohm +5% 1/8W smd 560-0105-202
MP 185(0.197 swage mount 013-1188-053]  |R028 |2.0k ohm *5% L/8W smd 560-0105-202
R029 |100 ohm 5% 1/8W smd 560-0105-101
PCBOOL|PC board, SN/SZ DSP (rev7) ~ |035-1825-180|  [R030 [270k ohm 5% 1/8W smd 560-0105-274
RO31 |10k ohm 5% 1/8W smd 560-0105-103
PL 001 |4-pin angle header, 1" center 515-9035-004 R 032 |10k ohm +5% 1/8W smd 569-0105-103
PL 002 [10-pin singleinline header 515-7100-010 R 033 |10k ohm +5% 1/8W smd 569-0105-103
PL 003 |10-pin single inline header 515-7100-010|  [R034 |10k ohm £5% 1/8W smd 560-0105-103
R035 |10k ohm 5% 1/8W smd 560-0105-103
ROOL |2.0k ohm +5% L/8W smd 560-0105-202
RO02 |4.7k ohm 5% L/8W smd 560-0105-472]  [SK 002 |Crystal socket 515-5006-018
(revised versions) SK 003 |Crystal socket 515-5006-018
0 ohm jumper 569-0105-001 SK 004 | Crystal socket 515-5006-018
(unrevised versions) SK 005 |Crystal socket 515-5006-018
R003 [270k ohm +5% 1/8W smd 560-0105-274
R Q04 82k ohm 5% cer smd 569-0105-823 1) 001 |Fixed point DSP TMS320V C5402 |544-5003-121
R0O05 160k ohm £5% cer smd 569-0105-164 | 002 |Audio CODEC PCM3002 544-3016-055
RQ06 270k ohm £5% 1/8W smd 569-0105-2741 {003 |64K x 163V SRAM MCM6323A |544-5001-130
RQ07 105 ohm £5% 1W smd 569-0175-05A U004 |256K x 16 FLASH AM29LV800  [544-9050-020
RO08 6.8k ohm £5% 1/8W smd 569-0105-682| |y 005 |Voltage regulator TPS7201QD  (544-2003-153
RO09 15k ohm £5% 1/8W smd 569-0105-153 {006 |voltagereg 3.3V TPS7333QD  |544-1020-009
RO10 18k ohm £5% 1/8W smd 569-0105-183 {097 |32K x 8 EEPROM AT24C256W  |544-1020-256
ROLL |18k ohm +5% L/8W smd 569-0105-182| | 008 |Op amp, quad MC3303 5A4-2020-008
RO12 15k ohm £5% 1/8W smd 569-0105-1531 {1 009 |Hex inverter SN74LVCO4A 544-3774-020
RO13 30k ohm £5% 1/8W smd 569-0105-303) {1 010 |Hex inverter SN74LVCO4A 544-3774-020
R 014 130k ohm +5% 1/8W smd 569-0105-303 |y 011 |Voltagereg 3.3V TPS7333QD  (544-1020-009
ROL5 10k ohm £5% 1/8W smd 569-0105-103) {012 |Busxcvr, octal SN7ALVCC3245  |544-1010-248
RO16 30k ohm £5% 1/8W smd 569-0105-303) {013 |Busxcvr, octal SN7ALVCC3245  |544-1010-248
RO17 |30k ohm +5% 1/8W smd 569-0105-303 |y 015 |Voltage regulator, 5V TL750M  |544-1020-750
RO18 18k ohm £5% 1/8W smd 569-0105-183 {016 |2input OR quad 74HC32 544-3766-032
ROL9 |2.0k ohm +5% L/8W smd 560-0105-202
R020 |10k ohm 5% 1/8W smd 569-0105-103 |y 001 |Crystal, 4.096 MHz smd £21-3060-061
R021 |10k ohm 5% 1/8W smd 569-0105-103
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3.3VD (DIGITAL)

REVISED DSP BOARD SCHEMATIC DIAGRAM
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